
A  B E T T E R  M A C H I N E .  A  B E T T E R  M A ¬ A Z I N E .A  B E T T E R  M A C H I N E .  A  B E T T E R  M A ¬ A Z I N E .

 112
DEC 
2005

SPECIAL REPORT: ALL THE BEST STUFF FROM MAC EXPO ’06  115
MAR 
2006

HOW TO: 
BRevive Dull Photos in iPhoto
B Baby Your ’Pod and ’Book Batteries
B  Change Unchangeable System Settings
B Back Up Your Files with Apple’s Backup 3
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Microsoft 
Offi ce jump 
through hoops
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MacBook Pro: 4x FASTER!
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We’ve got all the details on all the new 
features—plus some surprises!

iLife ’06
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Podcasting

. . .and more!
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BColor LaserJet 3600n
BOptura S1 DV camera
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56 Ask Us
Turn your Mac into a region-free DVD player, 
hack your menu bar’s date and time, and safely 
transplant your data from old Mac to new.

58 Revive Dull Photos in iPhoto
Tap iPhoto’s image-
editing tools to make 
mucked-up photos 
look better—without 
the artifi cial aftertaste. 
by Kevin Wolfe

60 Baby Your Battery
Treat your iBook, PowerBook, 
or iPod battery right, and it’ll 
serve you well for a long time. 
by Kyle Wiens

features

how to
62 Change Unchangeable 
System Settings
Hack Mac OS X’s hidden plist fi les to make 
frustrating system defaults more friendly—
and it’s not as scary as it sounds. 
by Niko Coucouvanis

63 Back That Mac Up
Don’t learn the importance of backups 
the hard way—use Apple’s Backup 3 and 
do it the easy way. by Niko Coucouvanis

20  iLife on Intel
Now that iLife ’06 and the Intel-based iMac and MacBook 
Pro are here, “digital lifestyle” is no longer just a marketing 
buzzterm—it’s a reality. by the editors of MacAddict
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a better machine. a better magazine.

28 Microsoft Offi ce Tricks 
Sick of having to jump through hoops to accommodate Offi ce’s quirks?
Train this ubiquitous software suite to behave the way you want it to. 
by Rick Altman, Maria Langer, Steve Schwartz, and Jake Widman

34 An AppleScript Arsenal
Even if you don’t know the fi rst thing about programming, you can 
harness the productive power of AppleScript. by Johnathon Williams
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 A POWERFUL MYTH
Contrary to popular belief, 
it doesn’t matter whether 
you completely drain and 
completely charge a LiIon 
battery every cycle. From 
“Baby Your Battery,” p60.

 CONTROL TIME
Don’t like the way Mac OS X’s 
menu bar displays the time? 
You can change it using the 
Terminal. From Ask Us, p56.

 UNSMARTEN WORD
If you’re typing for the Web 
in Microsoft Word, turn off 
the AutoFormat As You Type 
options. From “Microsoft 
Offi ce Tricks,” p28.

 BEFORE AND AFTER
When shooting video, start 
recording a little before your 
scene begins, and don’t stop 
for a few moments after it’s 
done. From Reviews, p48.

QUICK TIPS
FROM THIS MONTH’S ISSUE

48

47

10 Editors’ Page
And now for something completely geeky: four-drive SATA II 
RAIDs and heavy-duty protection for your Xsan fi le system.

12 Get Info
Sure, Apple’s announcements at the 2006 Mac Expo were 
awesome—but there were plenty of other great products 
hiding in Intel’s shadow. Also: Call of Duty 2 is incoming, 
and how to get free movies for your iPod.
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38 Aperture post-production photo wrangler
42 CEO Card Wallet iPod nano case
44 Color LaserJet 3600n color laser printer
42 Connect & Protect iPod nano case
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42 iPod nano Tubes iPod nano case
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45 iSongBook iPod companion
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48 Optura S1 digital video camera
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49 Slim DVD±RW DVD burner
42 Small iPod Gear Pouch iPod nano case
52 Stubbs the Zombie in Rebel Without a Pulse action game
47 Stylus C88 inkjet printer
50 Trigger Finger MIDI controller

55 The Hot List
We’d spend our own hard-earned money on these products.

78 Log Out

78 Letters
Is MacAddict fi lled with subliminal messages from the 
Great White North? Also: how one geeky reader iProposed. 

79 Contest
Dazzle us with your wit, and you 
could win Roku’s SoundBridge 
Radio, placing 10,000 Internet 
radio stations at your fi ngertips.

80 Shut Down
Fresh from the Expo: An early 
review of Apple’s fi rst integrated 
matchmaking solution system.
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Each month, one of our Disc-software categories 
emerges as the star of the silver CD. This month 
it’s tune time, with a passel of attractive apps 
for your listening, creating, and audio-managing 
pleasure. Oh yes, and there are 60 additional 
goodies for you to play with, as well.
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If you don’t receive the Disc with your copy of MacAddict, you might want to consider upgrading. Each monthly Disc contains cool 
demos, useful shareware and freeware, and the inimitable MacAddict Staff Video. To get 12 issues of MacAddict that include this value-
packed disc with your subscription (prorated if necessary) for just $1 more per issue, call 888-771-6222—the operator will take care of 
everything.

EDITORIAL  
EDITOR IN CHIEF  Rik Myslewski
MANAGING EDITOR  Sean Molloy
FEATURES EDITOR  Jake Widman
HOW-TO EDITOR  Niko Coucouvanis
REVIEWS EDITOR  Roman Loyola
WEB MONKEY  Nick Muerdter
EPONYMEDITOR  Max
CONTRIBUTING EDITORS  David Biedny, Joseph O. Holmes, 
Helmut Kobler, Cathy Lu, Steven Parke, Ian Sammis, Deborah 
Shadovitz, Andrew Tokuda, Michelle Victoria, Buz Zoller

ART
ART DIRECTOR  Mark Rosenthal
ASSOCIATE ART DIRECTOR  Peter Marshutz
PHOTOGRAPHER  Mark Madeo
CONTRIBUTING PHOTOGRAPHER Samantha Berg

BUSINESS
PUBLISHER  Bernie Lanigan, 646-723-5405
SOUTHWESTERN ADVERTISING DIRECTOR  
Dave Lynn, 949-360-4443
EASTERN ADVERTISING DIRECTOR 
Anthony Danzi, 646-723-5453
NORTHWESTERN ADVERTISING DIRECTOR  
Stacey Levy, 925-964-1205
EASTERN ACCOUNT EXECUTIVE
Larry Presser, 646-723-5459
NATIONAL SALES MANAGER, ENTERTAINMENT
Isaac Ugay, 562-983-8018
MARKETING DIRECTOR  Cassandra Magzamen
MARKETING COORDINATOR  Tara Wong
ADVERTISING COORDINATOR  Jose Urrutia, 415-656-8313

PRODUCTION
PRODUCTION DIRECTOR  Richard Lesovoy
PRODUCTION COORDINATOR  Ryan Meith

CIRCULATION
CIRCULATION DIRECTOR  Peter Kelly
NEWSSTAND MARKETING MANAGER  Bill Shewey
BILLING AND RENEWAL MANAGER  Betsy Wong
NEWSSTAND COORDINATOR  Alex Guzman
FULFILLMENT MANAGER  Peggy Mores
DIRECT-MAIL MANAGER  Stephanie Blake
DIRECT MARKETING SPECIALIST  Janet Amistoso

FUTURE US, INC.
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080
www.futureus-inc.com
PRESIDENT  Jonathan Simpson-Bint
VICE PRESIDENT/CFO  Tom Valentino
VICE PRESIDENT/CIRCULATION  Holly Klingel
GENERAL COUNSEL  Charles Schug
PUBLISHING DIRECTOR/GAMES  Simon Whitcombe
PUBLISHING DIRECTOR/MUSIC & TECH  Steve Aaron
PUBLISHING DIRECTOR/BUSINESS DEVELOPMENT  Dave Barrow
EDITORIAL DIRECTOR/TECHNOLOGY  Jon Phillips
EDITORIAL DIRECTOR/MUSIC  Brad Tolinski
DIRECTOR OF CENTRAL SERVICES  Nancy Durlester
PRODUCTION DIRECTOR  Richie Lesovoy

Future US, Inc. is part of 
Future PLC
Future produces carefully targeted 
special-interest magazines for people 
who share a passion. We aim to satisfy 
that passion by creating titles offering 
value for money, reliable information, 
smart buying advice and which are 

a pleasure to read. Today we publish more than 150 magazines in 
the US, UK, France and Italy. Over 100 international editions of our 
magazines are also published in 30 other countries across the world.
Future plc is a public company quoted on the London Stock Exchange 
(symbol: FUTR).

FUTURE PLC
30 Monmouth St., Bath, Avon, BA1 2BW, England
www.futureplc.com
Tel +44 1225 442244
NON-EXECUTIVE CHAIRMAN: Roger Parry
CHIEF EXECUTIVE: Greg Ingham
GROUP FINANCE DIRECTOR: John Bowman
Tel +44 1225 442244   www.futureplc.com
REPRINTS: For reprints, contact Ryan Derfl er, Reprint Operations 
Specialist, 717.399.1900 ext. 167 
or email: futurenetworkusa@reprintbuyer.com
SUBSCRIPTION QUERIES: Please email mcdcustserv@cdsfulfi llment
.com or call customer service toll-free at 888-771-6222.

   March 200608

AUDIO & MUSIC
Audiocorder (OS X) 4.6 shareware
Awaken 2.2.1 trial
CoverBuddy 1.3.1 demo
eXo Visualizer freeware
iStar Composer 1.0.3 trial
iTuneMyWalkman 0.91 freeware
Lounge Lizard EP-3 trial
Max Magic Microtuner 1.5.2
 shareware
MyStrands freeware
Peak LE 5.02 trial
Peak Pro 5 Demo Video
PodLock 1.1.4 demo
Reaktor 5 demo
SoundSoap 2 Demo Video
Traktor 3.0.1 demo

DEVELOPMENT
PHP Studio 1.1.1 shareware
REALbasic 2005 demo

FUN & GAMES
Ashalii 1.1 trial
Blixx 1.2 freeware
Boka Battleships (Classic) 2
 shareware
Boka Battleships (OS X) 2
 shareware
Bubblomania X 2.0 shareware
Gamepedia 2.3 trial
Racing Math trial

GRAPHICS & MULTIMEDIA
Coloriage 2 trial
disclabel 3.0.1 demo
DivX 6 trial
ffmpegX 0.0.9u shareware

Image Info Toolkit 2 trial
Kinemac demo
MacCapture 1.0 demo
PDF2Offi ce Professional 2.1.1 trial
Swift Publisher 1.1.1 demo
VLC Media Player 0.8.4 freeware

INTERFACE
Amnesty Widget Browser 1.1 trial
Check Off 3.5 freeware
Fox Trot Personal Search 1.0.4
 demo

INTERNET & COMMUNICATION
browseback shareware
DictJuggler 1.1 trial
DoorStop X 5.5 trial
Entourage Email Archive X 5.1
 shareware
OmniWeb 5.1.2 trial
Snak 4.1.2 shareware
Who’s There? 2 demo

PRODUCTIVITY
Bookends 8.1.3 tryout
Catalog 1.3.5 shareware
ConceptDraw V 5.5 demo
ConceptQ shareware
English-German Dictionary 4.1
 shareware
English-Italian Dictionary 8.1
 shareware
English-Spanish Dictionary 5.1
 shareware 
Faktura vX ERP 4 demo
HyperTranscribe demo
NoteBook 2.3.3 demo
OmniGraffl e 4.1 trial

OmniOutliner 3.5 trial
pdf-Offi ce 4 demo
PopChar X 1.3 shareware
StickyBrain 4 trial
TextWrangler 2.2.1 freeware
Tinybooks 1.2 trial
Typinator 2 trial

UTILITIES
A Better Finder Attributes 3.9
 shareware
AppZapper shareware
CDFinder 4.5.1 shareware
ChangeShortName 1.1.3 freeware
DiskTracker (Classic) 2.3.2
 shareware
DiskTracker (OS X) 2.3.2 shareware
Gotham Prime 3D Screen Saver
 shareware
iBatt 1.2.1 shareware
MoosePad 10.3 shareware
Salling Clicker 5.0.4 shareware
shadowBurn trial
TechRestore Demo Video
XBattery 0.7 shareware

SPONSORS
NoteBook 2.3.3 demo
OmniGraffl e 4.1 trial
OmniOutliner 3.5 trial
OmniWeb 5.1.2 trial
Peak LE 5.02 trial
Peak Pro 5 Demo Video
PodLock 1.1.4 demo
SoundSoap 2 Demo Video
TechRestore Demo Video

iStar Composer 
trial
Find lyrics on the Web, 
sync them to your 
songs, and 
play them in 
iTunes or on 
your ’Pod.  

PodLock demo
Your iPod is actually 
a lil’ ’puter—and this 
utility gives you 
control over 
your tune-
playing best 
friend. 

Reaktor 5 demo
This awesome software 
synth can produce 
every sound you can 
imagine. 
And even 
some you 
can’t.

Staff Video: The Half-Assed Clip Show
Here at MacAddict, we’ve spent the last month 
moving our offi ces (and chugging eggnog) instead of 
toiling over our monthly Staff Video—what better way 
to wriggle out of that responsibility than to follow a 
great television tradition?



The San Francisco Mac Expo was a 
doozy (see “Scene Report: Mac Expo 
2006,” p12, and “iLife on Intel,” p18). I’ll 
assume that your local newspaper hit the 
highlights, but I doubt they fed your Mac 
addiction with details about the geekier 
products on display. After all, it’s the 
rare reporter who knows—or even cares, 
really—that running 10-Gbps Ethernet on 
a standard LAN is constrained by the 90-
MBps bottleneck of AFP* over TCP/IP.

So I’ll take this opportunity to feed your hunger for some of the 
Expo’s gnarlier bits. You’ve been forewarned—if your taste doesn’t run 
to Deep Geek, turn to page 12, and I’ll see you next month.
•  That intentionally opaque reference to AFP two paragraphs above? 

Well, it describes one reason that Small Tree Communications 
(www.small-tree.com) developed Blaze, fi le-sharing software that 
bypasses the AFP bottleneck and allows speedy fi le transfers by, for 
example, connecting Macs equipped with Small Tree’s 10 Gigabit 
Ethernet cards to Fujitsu’s Ultra-Low Latency 12-Port Switches.

•  AMCC (www.amcc.com), a worldwide leader in high-performance 
data distribution, previewed the 3ware Sidecar, a four-drive SATA II 
RAID box connected to a highly optimized version of AMCC’s 3ware 
hardware-RAID-controller card (www.3ware.com). Projected read/
write speed for the system is 200 MBps; expect it midyear.

•  Another international biggie, BakBone (www.bakbone.com), was 
showing off NetVault for Mac OS X, an industrial-strength data-
protection app for Xserve, Xserve RAID, and the Xsan storage-area-
network (SAN) fi le system. No, it’s not designed to compete with 
.Mac’s Backup 3 (see “Back That Mac Up,” p63)—we’re talking 
protection for networks scaling from a busy video post-production 
house up to major corporations such as AT&T.

•  The world’s largest automated tape-system supplier and a heavy 
hitter in the data-management fi eld, ADIC (www.adic.com), was 
showing StorNext FX, software that works with Xsan and Xserve 
RAIDs to consolidate data and support access by machines running 
(hang in there—we’re almost done) AIX, HP-UX, IRIX, Red Hat Linux, 
SuSE Linux, Solaris, Unicos/mp, and … oh yeah … Windows.
The takeaway from all this geekifying? Not only did the Expo feature 

way-cool high-performance stuff, but more and more big boys are 
hopping on Apple’s bandwagon—and that bandwagon is in high gear.

    Enjoy,

Hard-Core Goodies

We’ll delve into the secrets of iLife ’06 and show you how to customize your iWeb pages, improve your favorite snaps, 
and more. Our guide to the habits of highly effective Mac addicts will show you how to work better and smarter, and our 
Field Guide will explore the hidden nooks and crannies of www.apple.com. We’ll also show you how to migrate to a new 
Mac, master iMovie HD 6’s Movie Themes, fl owchart your way to productivity with OmniGraffl e, and wear your heart (or 
whatever you photograph, print, and iron) on your sleeve. Finally, we’ll take close looks at M-Audio’s Podcast Factory, 
IRIS’s Readiris Pro 11 OCR software, Allume’s StuffIt Deluxe 10, Canon’s PowerShot SD30, and more.

comingsoon:april2006
Here’s what our editors are preparing for the next issue of MacAddict.

 

STAFF RANTS
Q. What’s the hottest thing you saw at the Expo?

Roman Loyola HAPPILY MARRIED (REALLY)
What’s the hottest thing you saw at the Expo?
The workout gals in the XtremeMac booth were hot. 
So were Casauri’s booth babes, dressed up as fl ight 
attendants, and the wandering cheerleaders—I didn’t catch 
what company they represented. Then there was G-Drive’s 

daily afternoon raffl e, which featured a honey in a tight T-shirt and bare 
midriff giving out the prizes. Oops—my wife’s on iChat. Hi, sweetie!

Sean Molloy DESTROYER OF WORLDS
What’s the hottest thing you saw at the Expo?
The Mac version of Google Earth is fi nally ready, and that’s 
pretty cool—but cooler still is the SketchUp Google Earth 
plug-in from @Last Software that lets you design your 
own Eiffel Tower, strip mall, Sphinx—or in my case, simple 

cube—and plunk it down somewhere on the planet to see if it clashes 
with the local color.

Mark Rosenthal QUARKOPHILE
What’s the hottest thing you saw at the Expo?
Quark’s new logo. No, seriously, even though MacAddict is 
an InDesign shop, I’m still a big fan of QuarkXPress. Maybe 
it’s because although I learned each and every Quark 
keyboard shortcut known to God or man, I’m still mastering 

the subtleties of InDesign.

Jake Widman FALSE MEMOIRIST
What’s the hottest thing you saw at the Expo?
Somebody at the HP booth took my picture with one of their 
new R-series cameras and used the in-camera slimming 
feature to make me look thinner. Kinda nice, kinda creepy. 
Couldn’t do anything about my hair, though.

Peter Marshutz iFASHIONISTA
What’s the hottest thing you saw at the Expo?
Rebe’s iPod cases. Certainly not my style, of course, but 
someone is fi nally putting more than a little fashion fl air into 
iPod accessories. Check out www.myrebe.com and see 
how far they’ve come from basic black.

Niko Coucouvanis METAFORAGER
What’s the hottest thing you saw at the Expo?
I was wowed by Steve’s masterful juggling act on the 
Mactel tightrope, balancing “This new stuff makes our 
current lineup (like the iMac G5 you bought last month) 
look like a pile of puke” with “Hang tight, pro users, we’ll 

release your Mactels later this year.”

Max SECRET AGENT MAN
What’s the hottest thing you saw at the Expo?
Being a guy with his pulse on the future of All Things Mac,

 I spent the entire Expo in secret hotel suites with curtains 
drawn, meeting with industry honchos about what they’re 

working on for Expo 2007. I could tell you what I saw (it’s gonna be 
great!), but then I’d have to kill you—and that would be quite rude, eh?

10 EDITORS’ PAGE
a note from the kernel
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*AppleTalk Filing Protocol, the fi le-sharing protocol used by clients and servers in an AppleTalk network—but you already knew that…



12  March 2006 

the news of the month in bite-size chunks

12

Remember Guy Kawasaki, the famed 
Apple Evangelist? He’s back, and this 
time he’s pushing FilmLoop (free, 
www.fi lmloop.com), a social network 
that features photo sharing. With 
the FilmLoop Player, you can view a 
continuously playing scroll of shared 
photos from members of your social 
network. If you’re into telling your own 
story, GroupSmarts’ MemoryMiner 
($60, www.memoryminer.com) lets you 
create personal and family histories 
with photos, video, audio, and maps. 
Traditionalists who’d rather have 
personal memories committed to a 
paper scrapbook might want to look at 
Intriguing Development’s scrapbook-
layout app iRemember ($49.95, www
.macscrapbook.com), which features 
tons of clip art and over 500 templates. 
Sign makers who use Avery Sign Kits 
for Windows can stop using that peecee 
and instead use Chronos’s SOHO 
Signs (free, www.chronosnet.com) 

with Avery Sign Kits on the Mac. REAL 
Software’s REALbasic 2006 Release 1 
($99.95 for Standard, $499.95 for Pro, 
www.realsoftware.com) is a developer’s 
tool that now allows you to translate 
REALbasic apps into multiple languages 
without recompiling, among many 
other new features. Frustrated by font 
management? Extensis’s 
Suitcase Fusion ($99.95, 
www.extensis.com) 
is a single-user font 
manager that combines 
features of Extensis’s 
Suitcase X1 and Font 
Reserve 3. Wannabe 3D 
artists who can’t afford 
a pricey 3D-animation 
app may fi nd salvation 
in Hash’s Animation: 
Master ($299, www
.hash.com), which 
supports spline-based 
modeling, animation, 
and rendering. Carina 

SCENE REPORT

MAC 
EXPO 2006
Go ahead, jump on the bandwagon and talk all you want about Intel Macs, iLife ’06, and everything else Apple announced at 

Mac Expo 2006—but there was plenty more to see inside San Francisco’s Moscone Center. If you spent most of your time 
drooling over the new Apple offerings (you know you were), or if you couldn’t make the trek to the City by the Bay, here are 

some of the many other products that caught our eye.

Software’s Voyager 4 ($199.95, www
.carinasoft.com) is astronomy software 
with realistically rendered stars, high-
resolution maps of planetary surfaces, 
and more. On Air ($39.95, www.equinux
.com) from equinux lets you monitor 
IP-based cameras via an interface that’s 
reminiscent of a TV control room.

G  FilmLoop lets you broadcast your pics to your pals.

G  Tell your family’s stories with MemoryMiner.

Cool Apps

Lots of treasures were hiding in 
the shadows of the Intel Macs.
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Hot Hardware
No, it’s not a life raft; it’s LaCie’s Neil 
Poulton–designed Rugged All-Terrain 
Hard Drive ($169 to $359, www.lacie 
.com). It has an aluminum case and 
orange rubber bumper, and it comes  
with FireWire 400, FireWire 800, and 
USB 2.0 ports. Sonnet’s Tempo SATA 
E4P ($299.95, www.sonnettech.com) 
is a PCI Express card with four external 
SATA II ports. WiebeTech’s SilverSATA V  
($139.95 to $3,379.95, www.wiebetech 
.com) is a five-bay storage enclosure 
that can be configured as a software-
based RAID array. Gefen’s HD-Mate 
($299, www.gefen.com) is a set-top box 
that lets you connect an Xbox 360, DVD 
player, and any other HDTV source to 
Apple’s 20- or 23-inch Cinema Display. 
Sling Media’s popular Slingbox ($249, 
www.slingmedia.com) is finally coming 
to the Mac. It delivers the TV broadcast 
into your home to your Mac through a 
broadband Internet connection. The 
KONA 3 ($2,990, www.aja.com) from 
Aja Video Systems is a professional PCI 
Express video-capture card that can 
capture uncompressed high-definition, 
Dual Link 4:4:4:4 HD, and standard-
definition video. Datacolor’s ColorVision 
Spyder2 Express ($99, www.colorvision 

Slingbox: Why 
work when you 
can watch All My 
Children instead?
H

Go rafting  
with LaCie’s  
Rugged Hard Drive.  E

Get calibrated 
with Datacolor’s 
ColorVision 
Spyder2 
Express.  E

.com) calibrates and matches the color 
of your camera, printer, and display. 
Speaking of color, you can add some to 
your iMac G5 with MacGear’s MacColors 
($49.95, www.maccolors.com), silicone 
covers that protect the iMac’s body.

G  The JBL On Time’s speakers literally 
surround your iPod.

F  Separated 
at birth: the 
iWoofer and 
Pokémon.

G  With iSee, you won’t have to squint  
so hard to watch your iPod’s video.

XtremeMac (www.xtrememac.com), and 
Targus (www.targus.com) all showed off 
their goods.

There were plenty of other intriguing 
’Pod products, as well. Speaker stands 
included Rain Design’s iWoofer ($129, 
www.raindesigninc.com), XtremeMac’s 
Tango ($199), and Altec Lansing’s 
iM11 ($99.95, www.alteclansing.com). 
Harman Multimedia’s JBL On Time 
($299.95, www.harman-multimedia 
.com) is a unique-looking iPod alarm 
clock that sets your ’Pod in the middle  
of a speaker arc. ATO’s iSee ($249, www 
.isee-ato.com) has a 3.6-inch LCD that 
lets you record and watch video—if  
your iPod is one of the models that  
can fit into its slipcase. Shure’s E500 
sound-isolating earphones ($499, www 
.shure.com) can switch between your 
music and a microphone that catches 
the audio around you. MicroOptical 
demonstrated its myvu video visor 
(price TBD, www.microoptical.net)—but 
video visors have come and gone before, 
so why should this one be any different? 
People just don’t want to wear ’em. 
—Roman Loyola and Michelle Victoria

iPod Goodies
Despite Steve Jobs’ keynote proclamation 
that this year’s Mac Expo was all about 
Macs, iPod accessory companies were 
everywhere we turned. Apparently, 
it’s not too late to jump on the iPod 
accessory bandwagon—there were 
several iPod case vendors that were new 
to us, including Bonus Resources (www 
.bonusresources.com), iDiddy (www 
.ididdy.com), Pacific Rim Technologies 
(www.pacrimtechnologies.com), Saffire 
(www.saffire-usa.com), and Sumo (www 
.sumocases.com). Of course, the usual 

’Pod suspects such as Belkin (www 
.belkin.com), Griffin Technology 
(www.griffintechnology.com), 

Marware (www.marware.com), 
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Carbon  
LoadedC
Finally, an iPod nano case that true geeks will love. C6 
Manufacturing’s Nano Case ($39.99, www.c6mfg.com) is  
made from aerospace carbon fiber and aluminum, and it has  
a cling-on screen protector. Stainless steel screws hold the 
nano in place and give the case a hip, industrial look. 

Shades of Blue(tooth)C
Motorola’s RAZRwire ($295, www.motorola.com) combines a pair of Oakley 
sunglasses with a Bluetooth wireless headset that works with Motorola’s 
RAZR V3c ($299) phone. The headset operates up to 30 feet away from the 
V3c, while the shades feature Oakley’s light O-Luminum frames and XYZ 
Optics to help maintain clarity at all angles.
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NEW STUFF

 
 

4SPIN CITY
iTTUSB
$199.99
www.ion-audio.com
Available: Now

 This belt-driven turntable connects 
directly to your Mac’s USB port. 
It comes with Audacity software 
that allows you to record your vinyl 
records, plus a trial version of 
Bias’s SoundSoap 2 for cleaning up 
the crackles in your recordings.

4VIDEO DIVA
DivX 6
$19.99
www.divx.com
Available: Now
The latest version of the DivX video 
codec has drag-and-drop video 
conversion, batch encoding, higher 
video quality, the ability to burn 
DivX files to discs, and more.

4SKY SPY
 XB-39 Eagleye
 $150
 www.estesrockets.com
 Available: Now
 This remote-controlled airplane 

has a built-in digital camera that 
can take 26 aerial shots. The plane 
has a 55-inch wingspan, 34-inch 
fuselage, and can reach altitudes 
of up to 1,000 feet.

 NEW STUFF

          Plays 
33s or 45s.

Drag-
and-drop 
converter  
for DivX.

In-flight meal 
not included.
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DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On

ON THE
DISC

DivX 6
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MASTER CHIEF GOES 
TO HOLLYWOOD

ANSWER THE 
CALL—AGAIN!
 Like the original, Call of Duty 2 rushes you through three 

major theaters of war as Russian, British, and American 
soldiers—this time in Stalingrad, Normandy, and Africa. The 
missions are heavily scripted, and you can skip to specifi c 
battles and take on side missions in any order you wish. A 
new grenade indicator tells you where explosions are about to 
go off near you, the enemy and allied AI has been improved, 
and you now have the ability to regenerate your health, Halo- 
style. You also get a bevy of multiplayer modes (including 
deathmatch, team deathmatch, 
capture the fl ag, HQ, and search-
and-destroy), optional VoIP chat, and 
13 maps on which to fi ght the good 
fi ght.—Matt Osborn

Did the mighty 
Zeus ever have to play zookeeper?

TIPS & TRICKS: FABLE: THE LOST CHAPTERS

Becoming a hero in Fable: The Lost Chapters 
is a long road, but it doesn’t have to be 
a lonely one. Whether you’re good and 
attractive or evil and horrifi c, these tips will 
help you share your life with that special 
someone, again and again.—MO
• Use the fl irt expression often on multiple 

women and watch their hearts grow; vulgar 
expressions have the opposite effect on potential mates.

• Your bride will see right through a fake wedding ring.

• There’s no need to give bank-breaking diamonds or 
rubies as gifts. Cheaper roses and chocolates work 
just as well.

• You can have multiple wives at once; it won’t affect 
your good or evil rating.

• Swing a different way? It’s possible for a guy to 
attract and marry a man in the kingdom of Albion. 
All you have to do is fi nd an attractable man.

• Neglect or abuse your wife, and she may divorce you, 
earning you 600 evil points.

Not quite the 
African safari 

you were 
hoping for.

Call of Duty 2
Price $49.99

Available 2006
Aspyr
www.aspyr.com

HERE COME THE AFTERSHOCKS
 The Strogg: No, it’s not Ikea’s latest furniture style—it’s 

actually a race of hostile aliens harvesting humans for spare 
parts and cybernetic experiments. Quake 4 picks up where 
Quake II left off, as the Space Marines head off to the Strogg 
home planet to get some well-deserved payback. Quake 4 has 
the same eye-popping production values and game engine 
as Doom 3—only this time, the pistol and assault rifl e come 
complete with fl ashlights (no duct-tape mod required). With 
its winding plot, objective-based gameplay, and AI-controlled 
squad members, Quake 4 is more single-player focused than 
you might expect. Online multiplayer smacks of Quake III: Arena, 
only with a 16-player cap for more-intimate mayhem.—MO

Quake 4
Price $49.99

Available 2006
Aspyr
www.aspyr.com

iTUNES PLAYLISTS ON YOUR PSP
 Say you throw a party with entertainment provided by 

iTunes on your Mac. Suddenly, the room is packed, your 
carpet becomes a dance fl oor, you can’t get anywhere near 
the Mac—and that one embarrassing 
David Hasselhoff song is about to 
start playing. Fire up CoverBuddy 
(hopefully you have Wi-Fi), put your 
Sony PSP into Web-browsing mode, 
and pow—your PSP is suddenly 
a full iTunes remote control. Now 
about your secret David Hasselhoff 
infatuation…—MO

Just what we’d 
expect a Strogg 

to look like.

Turn your PSP into an iTunes remote control.

CoverBuddy
Price $20

Available Now
three-2-one
www.coverbuddy.com

ON THE
DISC

CoverBuddy

You’re the one, I swear it.
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TIDY UP YOUR OPEN WITH MENU

>>>>>>>>>>>>>>>>>>>>>>>>>>>>
Bug of the Month

SHAREWARE PICK OF THE MONTH

ffmpegX http://homepage.mac.com/major4 $15

If you’ve ever tried to import those nutty MPEG fi les you fi nd on the Internet into iMovie, then you know that it 
doesn’t always work like it’s supposed to—frequently, for example, you’ll lose the video’s audio. The open-source 

app ffmpegX comes to the rescue. But before you can get rolling, you’ll have to do a bit of dirty work.—Andrew Tokuda

ON THE
DISC

ffmpegX

 The fi rst time you launch 
ffmpegX, you’ll need to install 
some fi les. Download them 
from the URLs listed and use 
the Locate buttons to fi nd them 
on your hard drive. Enter your 
Mac OS X password, and click 
Install.

2  The rest is easy. Drag 
your stubborn MPEG fi le to 
the From fi eld in the Source 
Format pane.

3  In the Target Format 
pane, click the arrow in 
the To fi eld to choose 
your output. For iMovie, 
choose DV.

 4  Click the Encode button to 
start encoding. The resulting 
fi le can be edited in iMovie or 
any editing application that 
works with DV fi les.

FREE iPOD MOVIES—
NO STRINGS 
ATTACHED

If you’ve exhausted the iTunes 
Music Store’s video offerings, 

try Public Domain Torrents (http://
publicdomaintorrents.com), full of 
links to public-domain movies such as 
A Star Is Born (1937) and A Farewell 
to Arms (1932). Not all of the movies 
are ’Pod formatted, but more iPod-
compatible movies are added daily. You 
need BitTorrent (free, www.bittorrent
.com) to download the movies. And don’t 
worry—these movies are in the public 
domain, so it’s perfectly legal for you to 
download them.—Roman Loyola

Download Gary Cooper and Helen Hayes to 
your video-capable iPod.

You’ve probably noticed that when you right-click a document (or Control-
click, for you die-hard one-button-mouse devotees) and select Open With, a 

hierarchical menu pops up with a list of apps you can use to open the document. 
Sometimes, lil’ gremlins get a hold of your Mac and add duplicate entries or 
inappropriate apps. Here are a couple of ways you can clean up the clutter in your 
Open With menu.
ZINGG! A utility such as Zingg (free, www.brockerhoff.net/zingg) lets you 
customize the Open With menu. You can specify apps for specifi c documents.
DOUBLE DUTY Duplicate entries usually happen because you have more than 
one version of an app on your hard drive. Get rid of older versions you don’t need. 
If you’ve ever run a Mac OS X Archive And Install process, look for archives that 
may have duplicate apps.

Eliminate 
duplicate 
entries in 
your Open 
With menu.
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Intel 101
>>>>>>>>>>>>>>>>>>>>>
A MONTHLY GUIDE TO INTEL BUZZWORDS

65-Nanometer Process
What it is: In microprocessor parlance, a process is 
the manufacturing method used to produce a chip. A 
process is commonly—if somewhat loosely—defi ned 
by the size of the transistors on the chip (the 
distance between the transistor’s source and drain 
terminals, for you übergeeks). A nanometer (nm) is 
one billionth of a meter, so a 65-nanometer chip 
is one with transistors that are about 1/10,000 the diameter of a brunette human hair.
What the PowerPC equivalent is: The dual-core IBM 970MP processor in the current 
line of Power Mac G5s is manufactured using a 90-nanometer process.
Why you should care: Intel recently released its fi rst 65nm chip, the Pentium Processor 
Extreme Edition 955. The Intel Core Duo processor that powers the new iMac and 
MacBook Pro also uses a 65nm process; and future chips that will likely wind up in 
Mactel boxes (code-named Conroe and Merom) are designed for a 65nm process. 

All else being equal, smaller is better in chip land. The distance a signal has to travel 
is shorter, increasing performance. The amount of power needed to run the chip is 
smaller, resulting in longer battery life. The number of chips that can be manufactured 
on a single slab of silicon increases, lowering costs. 

One catch: The smaller the process, the more electrical current tends to “leak,” 
causing heat problems. Intel currently addresses this problem with a technology called 
strained silicon, which improves electron fl ow and reduces leakage.—Rik Myslewski

Marty Flint’s Sculpted Nano Cases ($45, http://pixelgirlshop.com) use 
hand-oiled leather with designs suitable for proud urban warriors. The 

Urban Text Metallic (left) and Distressed Metallics (right) get their look 
from metallic foils and hand texturing. Marty Flint’s cases are exclusively 
distributed through PixelgirlShop.com, which also carries other unique ’Pod 
cases by Gerbera Designs, Emily Sessions, Lindsay Designs, and Jacqueline 
Myers-Cho—we especially dig her iPod Sock Monster ($30).—Michelle Victoria

iPOD CASE OF THE MONTH

SUBMIT YOUR CASE Whether your iPod case is a custom-made one-off or mass produced, you can 
submit it for Case-of-the-Month consideration—just send it to iPod Case of the Month, MacAddict, 4000 
Shoreline Ct., Ste. 400, South San Francisco, CA 94080. Please note that we cannot return cases.

• BeLight Software’s 
Swift Publisher 
1.1 ($39.95, on 
the Disc, www
.belightsoft.com) 
is a page-layout 
app for creating 
brochures, fl yers, 
and newsletters. 
It includes 23,000 
stock images and 
100 templates.

• Pantone’s huey 
($89, www
.pantone.com) is a 
consumer display-
calibration tool 
that helps ensure 
colors are accurate 
when viewing 
photos or the Web  
or playing games.

• BlueBox’s Image 
Info Toolkit 2 
($70, on the Disc, 
www.image-info-
toolkit.com) lets 
you include text 
info within JPEG 
and TIFF images 
that conforms to

International Press Telecommunications 
Council and Newspaper Association of 
America standards.

• Akvis’s Coloriage 2 ($97, on the 
Disc, www.akvis.com) colorizes 
monochrome images, black-and-white 
photos, or hand-sketched drawings. 
It can also replace colors in a color 
photo, selectively desaturate or 
colorize areas of an image, and more.

• Extensis’s Portfolio 8 ($199.95, 
www.extensis.com) is a digital-asset-
management app with new workfl ow 
features to organize and share 
fi les. This version features private 
and scratchpad galleries, better 
performance, and more.

• Recosoft’s PDF2Offi ce Professional 3 
($129, on the Disc, www.recosoft
.com) converts PDFs into editable 
fi les. New features include conversion 
to PowerPoint, font substitution, 

image-resolution 
fl exibility, and the 
ability to process 
math formulae and 
hyphenation.
—Michelle Victoria
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These cases help keep 
your iPod nano from 
being beyond repair.

Pantone’s huey: 
Step up to color 
accuracy.

ON THE
DISC

Coloriage, Image Info 
Toolkit, PDF2Offi ce 
Professional, Swift 
Publisher
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iLIFE ’06 SYSTEM REQUIREMENTS
Most of iLife ’06 requires Mac OS 10.3.9 or later. A 
few specific features (noted throughout this article 
where appropriate) require Mac OS 10.4.4.

   March 200618



T he revolution began five years ago with the quiet appearance 
of iTunes. Then there was the meteoric rise of the iPod and 
the carefully paced enhancements and integration of the 

iApps. Last year came the startling announcement that Apple would be 
switching to Intel processors. Steve Jobs has always said that his goal 
was to change the world—and now he’s pulled it off. Apple both walks 
the walk and talks the talk.

iTunes and iPhoto help us manage and enjoy digital content. iMovie and GarageBand both 
engage and encourage our creativity. Now with iWeb enlisting as a member of the iLife crew, 
photocasting joining iPhoto’s bag of tricks, and GarageBand making both audio and video 
podcasting as easy as, well, an Apple app, seamless sharing of creative projects completes 

the digital-lifestyle scenario.
Of course, creating digital media requires serious computing horsepower. 

That’s where Appel’s first Intel-powered Macs—the new iMac and MacBook 
Pro—come in; they bring the power of dual-core computing out of 

the rarified world of the pros and onto everyone’s desks (and 
laps). Just a few page flips away, our experts give you 

an in-depth look at these groundbreaking machines 
and all the new software they’ll make sing.

Once you’re done reading, go out and create 
your own world-class content. And—with Apple’s 

help—share it with the world.

“Digital lifestyle” is no longer just a        
 marketing buzzterm—it’s now a reality.

BY NIKO COUCOUVANIS, RIK MYSLEWSKI, AND JAKE WIDMAN
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Apple’s goal is to make us all look brilliant. Its latest slick, seamless,  
pro-quality digital-media production tools are here to assist.
Step back and ponder the big picture that Steve painted about five years ago with the introduction of the original iApps—a picture of 
your Mac as the digital hub for your creative endeavors in photography, video, and musical composition. iLife ’06 has finally made that 
image a reality. Not only does it help you easily create complex, media-rich projects, it also lets you share them in entirely new ways.

iWeb With all of iLife’s creative power at your fingertips, what’s the obvious thing to do with the mountains of 
content you can generate? Put it on the Web, of course! And right on cue, Apple’s given us a new app in iLife ’06—iWeb, 
the easiest Web-authoring tool we’ve ever seen. How easy is easy? Launch iPhoto, select a photo or 12, press the 
iWeb button, and then choose a template. iWeb 
automatically creates the page, uploads the 
photos, and places them for you.

After suffering with .Mac’s clumsy Homepage 
templates for five years, Web-bent iLifers have 
surely earned the right to a decent Web app. That’s 
“decent,” mind you—iWeb isn’t the most flexible or 
efficient authoring tool out there, but it’s simple to 
use, and the output looks fantastic. The app comes 
stocked with templates aplenty, ranging from 
straight-up options like White, Black, Baby, Kids 
Pink, Kids Blue, and Formal to racier choices like 
Freestyle, Night Life, and Road Trip. Each template 
contains all of the page layouts you usually find 
on a complete Web site, such as Welcome, About 
Me, Photos, Movie, Blog, and Podcast. As you add 
more subpages to your site, iWeb automatically 
generates a navigation bar at the top of the page. If 
the nav bar bugs you, tough luck. It’s the only element on an iWeb page that you can’t move—but we discovered that if 
you really, truly hate it, it’s possible to be sneaky and cover it up with an image or colored shape … heh, heh, heh. 

iWeb’s templates are more flexible than templates usually are; using drag-box handles or the Metrics Inspector, you  
can adjust page dimensions, margins, backgrounds, whether the page gets linked in the automatic navigation bar,  
and more. What you can’t do is create your own templates or save changes to the existing ones. Serious bummer. And  
while you can automatically publish your site to .Mac (if you have an account), you have to publish it to a folder and 

upload it yourself if you want to host it on your own domain  
or anywhere else.

Old-school Web geezers and geezerettes will cringe at 
iWeb’s output, since the app resorts to one of the oldest 
Web-design hacks in the book: creating individual PNG image 
files for every block of text you enter. Granted, this is 2006, 
and we’ve all got enough bandwidth to spare a few hundred 
kilobytes for an image file (actual text usually takes up only 
a couple of kilobytes), but when your busy blog reaches a 
few hundred posts, your .Mac account’s allotted 1GB disk 
space will seem paltry fast. Oh, and every blog post you make 
carries with it all of the page-trim graphics, unnecessarily 
eating another few hundred kilobytes of your Web space. 
iWeb needs a dose of Slim Fast, fast.

If you’re an old-school Web geezer, you won’t be seduced 
by iWeb anyway. But as a quick way to get a good-looking Web 
site up while drawing on the content you’ve created with the 
rest of iLife, iWeb does the job nicely.

iLife ’06

Even with all of its windows (Adjust Image, Colors, Font, Media Browser,  
and Metrics Inspector) open, iWeb isn’t the least bit threatening.

Each iWeb template includes samples for all the different kinds of pages 
you’re likely to want for your new site.
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iPhoto 6 iPhoto is arguably the most improved of the existing iLife apps. For starters, Apple claims 
iPhoto 6 can handle up to 250,000 photos, way more than version 5’s practical limit of 25,000. In our limited testing, 
this claim seemed reasonable—tune in next month for our full-scale, hypertested review. Other immediately apparent 
improvements include a new full-screen Edit mode, which displays photos you’re working on against a black background 

with nothing else but the editing tools showing (and 
even those can slip away like a hidden Dock), and a 
cluster of one-click effects that let you instantly apply 
Sepia, Black & White, Vignette, and other Core Image 
treatments.

iPhoto 6 introduces photocasting, the ability to 
publish photo albums to your .Mac account (assuming 
you have Mac OS 10.4.4 as well). Once iPhoto uploads 
the photos, the app generates an email with a link for 
you to send and share. If your recipients have iPhoto, 
clicking the link puts your shared album in their Source 
list, where they can do anything with the images that 
you can—edit, order photo books, whatever. It’s up 
to you whether they get full copies of your images or 
merely thumbnails. If your sharees don’t have iPhoto 
(or a Mac at all), they can use an RSS reader to pick up 
your shared images. When you update a shared album 
in iPhoto (say, “Cute Photos of Lil’ Kaneesha” shared 
by gramma), the ’casted version gets automatically 
updated as well. Slick. Waaay slick.

For old-timers who still appreciate photos on paper, Apple has improved iPhoto’s photo-book offerings and added 
calendars and greeting cards to the print shop. The calendars are especially slick—not only can you drop photos into the 
top panel of the calendar like they were iPhoto pages, but you can drag photos onto individual dates to mark birthdays 
or other events. iPhoto can also pick up calendar entries from iCal and drop the events and associated descriptions into 
your iPhoto project.

GarageBand 3 
If you’re an aspiring podcaster (and 
really, who isn’t these days?), do 
yourself and your potential audience 
a favor and get GarageBand 3. The 
new Podcast Recording Studio can 
make even the most sniveling, self-
aggrandizing drivel sound downright 
professional—well, professionally 
produced, at least. Starting with 
the new collections of Jingles and 
Stingers and a restocked Sound Effects 
collection, GarageBand has enough 
distracting ear candy that folks might 
not care that your podcast is a 15-
minute treatise on your own navel 
lint. A couple of well-timed cartoon 
boioioings can perk anything up. And to 
make sure that the soundtrack doesn’t 
completely drown out your voice, the 
new automatic Ducking feature lets you 
set GarageBand to lower the volume on 
background tracks whenever the vocal 
track kicks in—and you set the ducking 
on tracks individually, so you can leave 
those boioioings as nice and loud as 
you’d like.

Close up or far away? Full-screen editing or in a window? Matted or vignetted? 
iPhoto 6 is just full of possibilities.

Now you can score your soundtrack while viewing your movie right in 
GarageBand’s main interface.

Click the Podcast icon to load Jingles and Stingers. (Note: The Collins Avenue 
Long loop sounds suspiciously like a seventies porno soundtrack. How would 
we know? None of your business.)
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GarageBand 3 also has some new features for the true modernist who’s 
already joined the antipodcasting backlash. You can drag movie files or 
iMovie projects into GarageBand to create a new audio track with your movie’s 
soundtrack, which you’re free to edit just like any other Real Instrument track. 
Other nifty tricks include the ability to import other GarageBand projects into 
the current project, a new compact format that makes your project files small 
enough to email to other GarageBand users for remote collaboration, and 
an expanded 1,999-measure limit, enough for the most epic of rock-opera 
ballads.

iMovie HD 6 Over the years, iMovie has evolved from an ambitious-but-unintuitive, crash-prone, 
and generally annoying video toy into a powerful yet user-friendly app. Given version 5’s generous bounty of included 
audio support, video effects and transitions, and titling tools, you’ll be surprised at how deep version 6’s new bag 
of tricks is. The most obvious addition is the inclusion of Apple-designed iMovie Themes (Mac OS 10.4.4 required), 
prefab collections of elements (such as backgrounds, motion graphics, titles, and effects) that you populate with 

your own video, photos, 
soundtracks, and whatnot, 
mostly by dragging items into 
drop zones. We usually pooh-
pooh this kind of prefab junk, 
but iMovie’s templates are 
more than simple signposts 
and placeholders—they use 
advanced animation and 
compositing juju (or would that 
be mojo?) to seamlessly blend 
your media assets into the 
project. As always, all editing 
is nondestructive, so if you cut 
where you should have spliced, 
you can always get back to 
square one; even the refortified 
titling tools are more forgiving, 
providing real-time performance 
and leaving your title sequences 
completely editable.

We’ve spent more than 
enough time staring at iMovie’s 
progress bar to appreciate the 
new real-time effects previews. 
Now when you pick an effect 
(and if your Mac has the requisite 

guts), iMovie digs into Mac OS X’s Core Video technology to provide an instant preview in the main window. When you 
commit to an effect, iMovie 6 renders it in the background so you can get on with your projects. Yes, that’s projects—
mirabile dictu, iMovie finally lets you have multiple projects open at once. New audio effects come directly from OS X’s 
Core Audio, affording you tricks such as noise reduction for those times when your camcorder’s mic picks up too much 
wind noise, and fun audio manglers such as reverb, delay, and pitch shifting. Bonus: Don’t forget that all of GarageBand’s 
new sound effects and Jingles are right there in iMovie’s Media Browser for your cinematic indiscretion.

iDVD 6 Got widescreen? iDVD does, thanks to a stack of new 16:9 Themes—which are also available 
in good old kinda-squarish 4:3 format. More importantly, five of iDVD’s new themes correlate to the new iMovie 
Themes (Travel, Road Trip, Pass Through, Reflection White, and Reflection Black), making it easier than ever to pipe 
your project from the camera to a finished DVD. Too complicated? iDVD 6 has inherited iMovie 5’s magical authoring 
powers: Like iMovie’s Magic iMovie, iDVD’s Magic iDVD lets you simply choose a theme, pick the movies and photos 
you want on your DVD, and click the magic wand to bust out a basic disc. You can even tweak the project (edit titles, 
rearrange or remove clips, and so on) before burning. Easier still: You can use the OneStep DVD feature to dump 

Final Cut what? iMovie HD 6 is more than enough of a video app for the masses—and it now comes with 
Quartz Composer effects, such as Edge Work, above.
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Tip You can use GarageBand 
3 to record an interview: 

Simply fire up GarageBand and iChat, 
invite a friend or three to audio or video 
chat, and press Record. GarageBand 
records each participant’s chatter 
into a dedicated track. You don’t get 
the video, but GarageBand inserts a 
new marker and snapshot each time 
someone new starts speaking.



footage directly from camera 
to DVD for instant archiving or 
other no-frills purposes. 

For hands-on types who 
enjoyed iDVD’s earlier DVD Map, 
the new enhanced version is pure 
bliss. Want to rearrange a project 
by dragging and dropping icons? 
You can, and iDVD reconnects 
all of the dots for you, ensuring a 
fully functional DVD with no dead 
links or other embarrassing signs 
of amateur DVD authoring. Can 
DVD production get any easier?

iTunes 6.0.2 Still a free download and still fabulous, 
iTunes 6.0.2 is the least changed of the iBunch. The most notable change is 
a new MiniStore drawer that keeps a condensed version of the iTunes Music 
Store loaded at all times—at least until you click its icon in the lower right 
to hide it. Less visible is the addition of new content to the iTunes Music 
Store, such as 15-minute college-bowl-game highlight reels and (proof 

that Steve Jobs is a mind 
reader) Saturday Night 
Live Favorites, including 
memorable skits for $1.99 
a pop and longer (and 
more expensive) Best Of 
collections featuring the 
likes of John Belushi, Dan 
Aykroyd, and Will Ferrell. 
—Niko Coucouvanis and 
Jake Widman

 iDVD’s DVD Map is a vast improvement over what we got in previous versions.

Samurai Night Fever for 
$1.99? Bring it on!

iWork ’06 The updates to iWork—Apple’s $79 combo that includes the Keynote presentation app and the Pages 
word processor/page-layout app—are worthwhile, if not mind melting. Tables in either app now do simple calculations, not only 
saving time when you’re filling in data (you don’t have to enter the totals), but 
also allowing you to update your presentation or document by simply changing 
the data. Unfortunately and inexplicably, you can’t base any graphs in the 
same document on such a table—you still have to draw from the extra Chart 
Data Editor. 

You now have loads of new ways to change the appearance of Keynote charts, 
including 3D charts that you can gussy up with textures such as stone or wood. 
Individual textures are tied to particular presentation themes, so you can’t use a 
marble texture with a Raw Silk background, for example. Why, we can’t imagine—
we’ll need to query Apple’s Style Nazi.

iWork ’06 is not sold as an upgrade but only as a completely new, full-price 
package. The improvements might be enough to make it worth buying for those 
who weren’t enticed by the original iWork, but whether they’re enough to tempt 
current users into rebuying is another question. For most iWorkers, the answer 
might very well be “No.”—JW

Keynote 3 (part of iWork ’06) lets you present 
towering 3D monoliths of data. 
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iPod Radio 
Remote No, the iPod still 
doesn’t have a built-in FM tuner, but it now 
has the Radio Remote, a remote control 
and FM tuner in one small slab of plastic. 
The Remote plugs into the dock connector, 
and a pair of earbuds with a shorter-than-
normal cord plug into it. With it, you can 
control your iPod or listen to FM radio with 
the tuning info handsomely displayed on 
your iPod’s screen.—JW

The Radio Remote lets the ’Pod do FM—sorta.



Intel Inside
The Intel revolution has begun—ahead of schedule  
and with a powerful quartet of revolutionaries.

Two innovations flank the USB, 
digital-optical/analog audio-out, 
and audio-in ports on the left side 
of the MacBook Pro: on the far left, 
the MagSafe power port; on the far 
right, the ExpressCard/34 slot.

An extra USB port on the MacBook’s 
right side is welcome, but we would 
have appreciated FireWire 800 in 
addition to the single FireWire 400 
port. The tiny slot on the far left is a 
Kensington Security Slot to tether 
your precious traveling companion.

I f you bought a new iMac G5 during the three short 
months between its rollout on October 12, 2005 

and the announcement of the new Intel-based iMac on 
January 10, 2006, we feel your pain. Of course, your new 
iMac G5 is still a fine machine—the new iMac doesn’t 
lessen the “old” iMac’s greatness—but if you want to 
beat your head against the wall for a bit, we’ll spring for 
the Advil.

For the rest of us, however, Apple’s unveiling of the new 
iMac and MacBook Pro laptop is a cause for celebration. 
The Intel transition is officially underway—in spades. 
Citing pure processor-power benchmarks, Apple claims 
the iMac performs two times better than the previous 
model, and the MacBook Pro performs a startling four 
times better than the PowerBook. These boosts are due 
not only to the new Intel Core Duo processors (see “Intel 
Core Duo,” p25), but also by less-trumpeted upgrades 
such as a 667MHz frontside bus to swiftly shuttle data in 
and out of the processor, hard drives that use NCQ (native 
command queuing) technology to improve read and write 
performance, an internal PCI Express bus that supports an 
ATI Radeon X1600 graphics card, and—on the MacBook 
Pro—a new fast, hot-pluggable ExpressCard/34 slot that 
accommodates expansion cards based on either the PCI 

Express or USB 2.0 standards. We’re hoping that someone 
soon ships a FireWire 800 ExpressCard/34 to make up for 
the MacBook Pro’s lack of that speedy port.

We assume you’ve already pored over the specs for 
the new machines on www.apple.com, but—for the 
record—here are the basic configurations:
■ 17-inch iMac $1,299, 1.83GHz Intel Core Duo, 1,440-

by-900-pixel resolution, 160GB SATA hard drive
■ 20-inch iMac $1,699, 2GHz Intel Core Duo, 1,680-by-

1,050-pixel resolution, 250GB SATA hard drive
■ MacBook Pro $1,999, 1.67GHz Intel Core Duo, 1,440-

by-900-pixel resolution, 80GB SATA hard drive
■ MacBook Pro $2,499, 1.83GHz Intel Core Duo, 1440-

by-900-pixel resolution, 100GB SATA hard drive
The first three machines ship with 512MB of DDR2 

SDRAM and 128MB of video RAM; the 1.83GHz MacBook 
Pro bumps those to 1GB and 256MB, respectively, and all 
four max out at 2GB of SDRAM. The iMacs have double-
layer SuperDrives, while the MacBook Pros are limited 
to single-layer DVD and CD burning. All four have built-in 
AirPort Extreme, Gigabit Ethernet, Bluetooth 2.0, and 
iSight cameras, and each ships with an IR remote and 
Apple’s Front Row media-center software. None, however, 
include a modem—a V.92 USB unit is a $49 option.
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iLife
Intelon

The itty-bitty 
rectangle 

between the two 17-inch-
PowerBook-style latches 
is the built-in autofocus 
iSight camera.

At one inch slim and 5.6 
pounds, the MacBook Pro  
is a petite powerhouse. This 
tiny hole, by the way, is the 
IR port for the Apple  
Remote.



Intel Core Duo At the heart of the new iMac and MacBook 
Pro is Intel’s dual-core microprocessor, the Core Duo (née Yonah). The 151 million 
transistors in this mighty midget provide killer performance that should leave 
both the PowerPC G4 and single-core G5 in the dust. Here’s a quick peek at some 
of the technologies that should vault the new Intel Macs past their predecessors.
■ Dual Cores and HT Technology The Core Duo has two processor cores to blast 
your apps into light speed—but the performance boost doesn’t stop there. The 
Core Duo also takes advantage of Intel’s HT (Hyper-Threading) technology, which 
essentially allows each core to handle two tasks at once. Mac OS X and cleverly 
coded apps can treat the dual-core Core Duo as four processors. Under ideal 
conditions, a Core Duo can do four times as much work per clock cycle than a 
single-processor, non-HT chip. (The real world, we hasten to add, is rarely ideal.)
■ Smart Cache The Core Duo has a single on-chip 2MB L2 (level two) cache, 
where the two cores stash frequently used data and instructions, thus 
eliminating the need to reach out to slower main RAM or a relatively turgid hard 
drive for that information. The smart part of the Smart Cache is that each core has 
access to the entire cache, and the Core Duo uses a process called dynamic cache 
allocation to ensure each core has the amount of cache space it needs at any 
given moment. What’s more, data modifi ed by one core can be blasted into the 
cache and immediately accessed by the other core. Slick, eh?
■ Digital Media Boost The Velocity Engine (aka AltiVec) in the G4 and G5 
boosts media processing—one distinct advantage that Motorola’s and IBM’s 
chips had over Intel’s similar (but not quite as hot) SSE2 technology. The Core 
Duo, however, includes enhancements to SSE2 called, unsurprisingly, SSE3, 
fi rst introduced in the Pentium 4 and now specifi cally optimized for the Core 
Duo. Called Digital Media Boost by Intel’s marketing folks, this technology 
combines with beefed-up fl oating-point processing to promise better media-rich 
performance. Will it actually catch—or even pass—the Velocity Engine? We’ll have 
to wait to get our hands on a new Intel-based Mac to fi nd out.
■ Dynamic Power Coordination The Core Duo may be the most power-effi cient 
chip ever—so miserly, in fact, that despite its dual cores, it consumes about as 
much juice as its single-core mobile predecessor, the Pentium M. A number of 
technologies contribute to this battery-saving frugality. Enhanced SpeedStep 
Technology can turn off parts of the chip (even an entire core) that aren’t being used, 
then snap them back to life as quickly as one clock cycle. Also, the aforementioned 
Smart Cache can fl ush and power down the entire L2 cache during periods of 
inactivity, allowing the Core Duo to slip into Enhanced Deeper Sleep mode, saving 
even more power. It can even snap out of this slumber instantaneously.—RM

The new iMacs include a mini-DVI 
port and support an extended desktop 
if you attach an external display. The 
MacBook Pros have a dual-link mini-DVI 
port that can support the full 2,560 
by 1,600 native resolution of Apple’s 
mongo 30-inch Cinema HD Display. 
The MacBook Pros also have one nifty 
innovation: The MacBook’s 85-watt 
power brick provides juice through a 
magnetic power connector that Apple 
calls MagSafe. If you trip over the cord, 
the MagSafe connector pops off, saving 
your MacBook from a trip to the fl oor. 
It’s one of those little Apple engineering 
niceties that make us all proud to be 
Mac addicts.—Rik Myslewski

Being MacAddict editors and veteran Mac observers, Niko, Rik, and Jake are a jaded 
lot—but even they were blown away by the quality of Apple’s latest announcements. March 2006   25

The iMac has ports 
aplenty: (from left) 
digital-optical/
analog audio out,
audio in, three 
USB, two FireWire 
400, one 10/100/1000Base-T 
Gigabit Ethernet, and (at long last) 
a mini-DVI port that supports an 
extended desktop.

Rosetta Mac OS X and all of 
its attendant apps, including iLife ’06, run 
natively on the Core Duo chip inside each 
new Intel Mac. But what about all your other 
applications? The good news is that by 
mid-January there were already over 200 
Universal Binary apps—that is, those that run 
on both PowerPC and Intel chips. The better 
news is that Apple has provided a transition 
strategy with its Rosetta technology, which 
translates PowerPC code into instructions 
that a Core Duo chip can execute.

The keyword here is translates. Unlike 
the Classic mode that eased our way from 
OS 9 to OS X, Rosetta works its translation 
magic completely transparently. Mac OS 
X simply senses if your app is written for 
PowerPC or is a Universal Binary; if it’s the 
former, Rosetta steps in to translate it—no 
“mode” launches to take care of business. 
Day-to-day tasks such as writing in Word or 
performing undemanding Photoshop functions 
feel reasonably snappy, but time-dependent 
apps such as video or sound editors—and, 
possibly, turbulent and graphically intensive 
games such as Doom 3—will almost certainly 
struggle. Case in point: Apple doesn’t support 
any of its pro apps in Rosetta. Final Cut Pro 
5 and its Final Cut Studio compatriots need 
not apply, for example, but Apple promises 
Universal Binary upgrades soon. See www
.apple.com/rosetta for details.

What about your Classic apps, you ask? 
Unfortunately, it’s the end of the line for them. 
Pack them away with your buggy whip, carbon 
paper, and 8-track tapes. That may sound 
harsh (it is harsh, actually) but OS X is fi ve 
years old. It’s time to move on, folks.—RM
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by Rick Altman, Maria Langer, Steve Schwartz, and Jake Widman

If you’re like most Mac users, you use Microsoft Office daily to write letters, crunch numbers, make slides, check email, or 
schedule your life. What you probably don’t know is that Office has considerable hidden powers—more than most users will ever 
discover. In the following pages, our experts let you in on Office’s secrets, answer some common questions about its potential 

and peccadilloes, and offer some of their favorite tips for getting the most out of this sprawling suite—both Office v. X and 2004. 

Sick of having to jump through hoops to accommodate Office’s quirks? Here’s 
how to train this ubiquitous software suite to behave the way you want it to.

MicrosoftOffice
Tricks
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WORD
These tips can make the world’s most popular word 
processor (well, the most common) a more helpful 
and less frustrating writing partner.

If you’ve got text formatted in 
a character style (identifi ed in 
the Formatting Palette by an 
underlined a) that’s based on a 
paragraph style (identifi ed by 
a ¶), choosing the underlying 
paragraph style won’t remove 
the character style.

Q. Why do I frequently have to choose Clear Formatting in the 
Formatting Palette or Style pull-down before choosing a new 
style? Shouldn’t Word just know how to apply the new style? 
A. This is usually a problem caused by overlapping paragraph 
and character styles. For example, say you have a paragraph 
style called Standard Text that specifi es (in addition to spacing, 
alignment, and other paragraph formats) the font to be Times 
New Roman. In addition, you have a character style called 
Italic Text, based on Standard Text but specifying Times New 
Roman Italic. If you format a paragraph as Italic Text, it takes 
on the Standard Text formatting plus the italic version of the 
font. But if you then format that paragraph as Standard Text, 
nothing changes—because it already is Standard Text, just 
with an additional font specifi cation on top of it. Choosing the 
paragraph style won’t remove the additional character style.

That’s why you must fi rst select Clear Formatting or defi ne 
Italic Text (and your other frequently used styles) as paragraph 
styles to begin with. It’s a little more work up front, but it will 
save you frustration later.

Q. What’s the Style Gallery for?
A. Where you fi nd it (Format > Theme > Style Gallery) clues 
you into its purpose. Word comes with an assortment of 
theoretically useful templates. If you choose Select The Type Of 
Installation You Want > Select All in the Setup Assistant while 
installing Offi ce, you get a boatload of them, from Babysitter 
Notes (for those who use their Macs to write notes to their 
babysitters) to Whimsy. Each template includes defi nitions for 
a standard set of styles. The Style Gallery lets you see what 
your current document would look like if you used one of the 
templates—just click the Document button in the Preview area 
to see the changes.

Want to see what your table would look like in the Pet Medical 
Record template? The Style Gallery can show you.

Q. What’s the difference between Tools > AutoCorrect 
> AutoFormat As You Type and Tools > AutoCorrect > 
AutoFormat? I’m thinking mostly of the options listed under 
Replace As You Type and Replace (such as the “Straight 
Quotes” With “Smart Quotes” option). 
A. It’s fairly straightforward: The fi rst option makes its changes 
as you type, so that the straight quotes ("") get replaced with 
curly quotes (“”) right away. It’s probably the better choice for 
something you’re writing yourself. The second option sets up  
what happens when you choose Format > AutoFormat. At that 
point, Word goes through an existing document and makes all 
the changes in one pass. This is useful if you’re working on a 
document (such as an email) that doesn’t have curly quotes or 
proper em dashes (—, Shift-Option-hyphen).

Jake’s Top Word Tip
Why settle for the default? Word’s off-the-

shelf toolbars have items you’ll probably 

never use, while some of the other toolbars 

might have features you’d like to have 

accessible all the time. Luckily, it’s easy to 

mix and match to create your own custom 

toolbars. Just choose View > Toolbars > 

Customize Toolbars/Menus (in Word v. X, 

it’s just Customize). Drag any buttons you 

don’t want off the toolbar that you plan to 

have open all the time. Then click the toolbar 

that has the button you want, and drag any 

buttons you want to your custom toolbar. 
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Q. I want to send a form letter written in Word to a bunch of 
people in my Entourage Address Book. Is there an easier way 
to do this than copying and pasting the names and addresses 
from Entourage?
A. Yes, there is. In Word, choose Tools > Data Merge Manager to 
open the Data Merge Manager palette. (If you’ve already written 
your letter, do this with the letter document open; otherwise, 
do it in a new blank document.) In the Main Document section 
of the palette, choose Create > Form Letters. Then, in the Data 
Source section, choose Get Data > Offi ce Address Book. Drag the 
fi eld names you want from the Merge Field section (First_Name, 
Last_Name, Street, and so on) into the appropriate places in 
your letter—remember to leave spaces between the First_Name 
and Last_Name fi elds. Next, in the Merge section of the palette, 
choose Query Options. If you’ve already grouped all of your 
intended recipients into a category, just choose it from the list; 
if you haven’t, choose Complete Record from the pop-up menu 
to see your entire Address Book, and check the names you want. 

In the Preview section of the palette, 
click the View Merged Data button 
(ABC topped by right- and left-facing 
angle brackets) to see your form letter 
with the fi rst name’s information in 
place—use the Previous Record and 
Next Record buttons to check other 
names. Finally, in the Merge section, 
click the Merge To Printer button to 
send the letter directly to the printer, 
or choose Merge To New Document 
(the second button) to make a new fi le 
containing all the letters sequentially.

One more tip: Format the fi elds the 
way you want before doing the merge. 
The imported records will take on 
whatever formatting you applied to 
the fi eld names.—Jake Widman

Use your Entourage 
Address Book as the 
source for a mail-merge 
operation. Insert and 
format the fi elds you 
want, and spam your 
friends. 

EXCEL
Just as there’s more to math than simple arithmetic, there’s more 
to Offi ce’s number cruncher than mere rows and columns.

Q. What’s the difference between the Split and Freeze Panes 
commands under the Window menu?
A. These two commands appear to do pretty much the same 
thing, but there are important differences. Window > Split 
splits the window into four panes with the active cell at their 
intersection. Each pane can be scrolled sideways or up and down, 
and you can enter or view data in each—you can even view the 

same data in all four window 
panes. Use this command 
if you need to work on two 
widely spaced areas of a large 
worksheet at the same time.

The Freeze Panes command 
also splits the window at the 
active cell, but in this case 
the top and left panes are 

Split (above) lets you scroll all panes freely, while Freeze 
Panes locks a chosen part of the worksheet.

Leave Me Alone!
Word likes to do a lot of things for you 

automatically—but we prefer to decide for 

ourselves what we want Word to do, thank 

you very much. So the fi rst thing we do with 

a new copy of Word is decline a lot of its 

“help.” For example:

• In Word > Preferences > Spelling And 

Grammar, uncheck Check Spelling As 

You Type and Check Grammar As You 

Type to get rid of those annoying little 

red and green squiggles (the quality of 

Word’s grammar checking is, to be kind, 

suboptimal).

• The Font menu’s a lot less responsive 

when it displays the actual fonts. For 

a quicker, plainer menu, go to Word > 

Preferences > General and uncheck 

WYSIWYG Font And Style Menus.

• While you’re there, uncheck Show Project 

Gallery At Startup to go right to a blank 

document without being asked whether 

you want to make labels.

• To type URLs without having them turn 

into clickable (and impossible-to-edit) 

links, open Tools > AutoCorrect, click the 

AutoFormat tab, and uncheck Internet 

Paths With Hyperlinks. If you don’t like 

Word grabbing your numbered items 

and automatically turning them into a list, 

uncheck Lists and Automatic Bulleted Lists 

in the same dialog.

• Also in that same dialog, click the 

AutoCorrect tab and enter some of your 

most common typos and how Word should 

correct them—here’s an example of when 

Word’s helpfulness is actually welcome. 

Lots of common typos (such as taht for 

that) are already in the list, but we’re sure 

you can fi nd some more to add.
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Maria’s Top Excel Tip
Save time by modifying Excel’s default chart to meet your usual 

charting style. First, create or open a chart formatted the way you 

like. With the chart active, choose Chart > Chart Type. In the Chart 

Type dialog, click the Custom Types tab. Your chart should appear 

in the Sample area. Click the User-Defined radio button if it’s not 

already selected. Click Add, and enter a name and a description 

for the chart in the resulting Add Custom Chart Type dialog. Click 

OK. Now your custom chart appears in the Chart Type list. Select 

its name and click the Set As Default Chart button. Click Yes in the 

confirmation dialog—from that point forward, the default chart type 

will be the one you created.

You have to find your way to the Edit 
Hyperlink dialog to disable a link in your 
spreadsheet.

Q. Whenever I type a URL into a cell all by itself, the text turns 
blue and becomes an underlined, uneditable, clickable link—
it’s driving me crazy! How do I stop Excel from doing that? 
Also, how do I change a clickable URL back into regular text?
A. To enter a URL without having it turn into a clickable link, just 
start it with an apostrophe (’)—the apostrophe won’t appear in 
the cell. To remove a link from a URL that’s already in a worksheet 
cell, select the cell with the URL in it—you may have to use the 

arrow keys if you 
can’t click it without 
actually clicking the 
link—and choose 
Insert > Hyperlink 
(or press Command-
K). Then click the 
Remove Link button 
in the Edit Hyperlink 
dialog that appears.

Q. I want to enter data into a group of cells and move between 
cells without using the mouse. Is this possible?
A. Yes, it’s possible—and it’s easy. Select the cells you want 
to enter data into. One of those cells will be the active cell—the 
one that’s white with a selection border. Enter data into that 
cell, and press Return to move to the cell below it. Repeat this 
process until you’ve entered data into all selected cells—and as 
you’ll see, when you get to the bottom of one column, Excel will 
automatically move to the top of the next.

This technique even works for noncontiguous selections—just 
hold down Command while selecting each group of cells. If the 
active cell isn’t the one you want to be active, just press Return 
until you get to the one you want. You can change the direction 
that Excel uses to move to the next cell in the drop-down menu 
at Excel > Preferences > Edit > Move Selection After Return. 

You can use Return 
to move from cell 
to cell—and control 
the direction of 
movement with a 
setting in Excel’s 
preferences.

Just-in-Case Formatting
Conditional formatting makes it possible to automate cell formatting based on cell contents—it can make specific quantities 

easier to spot. For example, suppose you want every value over $2,000 in a range of cells to appear bold and blue. Select the 

range of cells in which you want this to occur, and choose Format > Conditional Formatting. In the Conditional Formatting 

dialog that appears, choose Cell Value Is from the first menu, select Greater Than from the second, and enter 2000 in the third 

field. Click the Format button and set the Font Style to Bold and Color to Blue. Click OK to see an example, and click OK again. 

From now on, any cells in the range you selected that are greater than $2,000 will appear bold and blue.

Unlock cells before you protect them in order to be able to enter 
data into them afterwards. Once locked and protected, they’re, 
well, locked and protected.

Q. I want to use protection (Tools > Protection) to prevent 
myself from accidentally overwriting a formula. But when 
I turn it on, I can’t enter data in any cell at all! Am I doing 
something wrong?
A. You’re probably not unlocking the cells you want to enter 
data into. By default, all cells in a worksheet are formatted 
as locked with protection turned off. Since protection is off, 
you can enter data into any cell. But when you turn protection 
on, you make it impossible to enter data into any cell because 
they’re all locked.

Here’s the trick: First (before you apply Protection) select the 
cells into which you want to be able to enter data. Then choose 
Format > Cells and click the Protection tab in the Format Cells 
dialog that appears. Uncheck Locked and click OK. Then go 
about protecting the sheet as usual: Choose Tools > Protection > 
Protect Sheet, make sure the Contents check box is turned 
on in the Protect Sheet dialog, and click OK. The sheet will be 
protected, except for those cells you unlocked first. 
—Maria Langer

frozen in place (when you’re scrolling up and down or sideways, 
respectively), while you scroll the rest of the window. Use this 
command to lock row or column headings in place while you 
work on the rest of the spreadsheet. 
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Steve’s Top 
Entourage Tip
When you set up multiple accounts in Entourage, 

you don’t get a separate set of folders for each 

one. As a result, all of your incoming messages 

are simply tossed all together into a single Inbox. 

To make them easier to find, create a folder 

for each account (File > New > Folder), and 

then make a message rule (Tools > Rules) to 

automatically route mail. Set the Criterion to Any 

To Recipient Is email address and the Action to 

Move Message folder name. Finally, remove the 

superfluous second action Entourage created.

Q. Whenever I start to address a message, I get a list of 
suggested email addresses, some of which aren’t in my 
Address Book. Can I control the contents of this pop-up list?
A. When you begin typing an address or name in the To, Cc, or 
Bcc field of a message, Entourage displays possible matches 
based both on your Address Book and on addresses in recent 
emails. You can manage this list via Entourage > Preferences 
> Mail & News Preferences > Compose. To restrict the list to 
contacts in your Address Book, uncheck Display A List Of 
Recently Used Addresses When Addressing Messages. You can 
also click Clear List to remove all non–Address Book entries 
from the list.

ENTOURAGE
There’s more to Entourage than simple email— 
here’s how to turn it into a first-class office assistant.

Q. How do I back up my email?
A. The simplest way to back up an Entourage folder (such 
as your Inbox) is to drag its icon onto your desktop. Doing 
so creates an MBOX file that you can later restore by double-
clicking (you can even drag it into another email client, such as 
Mail). To back up subfolders or other main folders, you must 
create a separate MBOX file for each folder and subfolder.

To back up all of your Entourage data, make a copy of your 
identity folder (/user name/Documents/Microsoft User Data/
Office 2004 Identities; if you’re using v. X, it’ll be called /Office 
v. X Identities; if you’re on a single-account machine, it’ll be 
called /Main Identity). In Entourage 2004 (not v. X), you can also 
use File > Export to create an RGE archive that contains separate 
MBOX files for all mail folders. To restore your data, either 
double-click the archive or choose File > Import; Entourage will 
place the entire archived mailbox in a new folder. Alternately, 
you can Control-click the archive, choose Show Package 
Contents, and select particular folders to import.

Q. Can I use Entourage to send and receive messages from 
Web-based email accounts?
A. As long as the provider has POP (Post Office Protocol) mail 
servers for this purpose, you can use Entourage in addition to or 
instead of a browser. Here’s how:

HOTMAIL When Entourage 2004 was released, MSN removed 
POP support from free Hotmail accounts, allowing it only for 
premium accounts. If you’ve got one, add it to Entourage like so: 
Choose Tools > Accounts. Click the New button in the Accounts 
dialog. When prompted by the Account Setup Assistant, enter 
your Hotmail email address and password.

GMAIL If you just want to pick up your Gmail messages in 
Entourage, you can have them automatically forwarded to 

To access your 
Gmail account 
in Entourage, 
make changes in 
the Forwarding 
And POP section 
of Gmail’s Mail 
Settings page.

Restrict Entourage’s address suggestions to your Address 
Book to avoid unwanted or misspelled options.

another email account you already have. To do so, go to your 
Gmail account, click the Settings link, and then click the 
Forwarding And POP tab. In the Forwarding section, click 
Forward A Copy Of Incoming Mail To, and enter the address 
where you’ll pick up your mail. Select a mail-handling option 
from the pop-up list and click Save Changes.

If you also want to be able to send Gmail from Entourage, 
instead click Enable POP For All Mail (to download existing Gmail 
messages as well as new ones) or Enable POP Only For Mail That 
Arrives From Now On (to download only new messages). For 
instructions on setting up the Gmail account in Entourage, click 
the Configuration Instructions link.

YAHOO MAIL POP access is only available for Yahoo Mail  
Plus accounts ($19.99 per year). To configure Entourage, enter  
pop.mail.yahoo.com as the incoming mail server and smtp.mail 
.yahoo.com as the outgoing server.—Steve Schwartz

   March 200632



March 2006      33

Q. I need to merge my boss’s presentation with mine, but 
whenever I try, the whole thing turns into dog meat. How can I 
put the two presentations together and save my job?
A. There are two routes to take to merge presentations and 
two options to take in either route—that’s four ways to create 
dog meat if you don’t think ahead. First question: Do you want 
your boss’s presentation to keep the design it currently has, or 
do you want it to take on the look and feel of your presentation 
when you incorporate it? 

Either way, start by opening your presentation. Choose Insert > 
Slides From File, and navigate to your boss’s presentation. If you 
want the merged presentation to look like yours, just click Insert 
All Slides, and then click Insert. If you want your boss’s slides 
to keep their existing look (or if you’re only bringing a few slides 
over), click Select Slides To Insert, and then click Insert. In the 
resulting dialog (which conveniently has an Insert All button), 
you also get a Keep Design Of Original Slides check box.

POWERPOINT
This presentation app can make you look brilliant— 
especially if you’ve got a bit of a sneaky side.

Q. I like my presentations to be lively, so I try to have the 
title of each slide fly in and the bullet points look like they’re 
being typed—but setting the animation on every slide is time 
consuming and tedious. Is there a better way?
A. Sorry, there’s no better way. Please just avoid animation 
in your presentations—trust us, your audience will thank you. 
OK, OK, actually, there is a better way. But before we tell you, 
you have to promise not to abuse your powers. Choose View > 
Master > Slide Master, and note that virtually every command 
and feature that you’ve used during slide editing is available, 
including the animations from Slide Show > Preset Animations 
(or Custom Animations, if you want to be unconscionably cruel). 
Select your title and set its behavior, and all the titles in your 

presentation will act the 
same way.

Choose Insert > Slides From File to merge another presentation 
with your current one (left) and have the slides take on your current 
presentation’s appearance (right).

Q. We design our presentations to mirror our Web site.  
Can we make the hyperlinks function?
A. With ease. Any object that you create or import can have 
an action associated with it. Just select the object and choose 
Slide Show > Action Settings. Click the Mouse Click tab, choose 
Hyperlink To, and select URL from the drop-down menu. Enter 
the URL in the resulting box, and you’re good to go.

You might not like the look, though, because the text will 
change color and inherit an underline, just like a hyperlink in 
a browser. A better way is to draw a rectangle over the text, 
assign the action to the rectangle (rather than the text), and 
then make the rectangle invisible by removing its outline and 
fill.—Rick Altman

Set animations for the 
whole presentation in 
the Slide Master—if you 
must—and preview them 
on a miniature of one of 
your slides.

Rick’s Top PowerPoint Tip
You can’t always control the time it takes to give a presentation, and 

you can’t always guarantee that you’ll have the amount of time you 

were promised. The last thing you want is to have to hurry through 

your final slides. You need a bailout strategy, and Action Settings can 

help you create it. Identify two or three slides in your presentation 

that represent sections you want to make sure to cover. Then create 

hyperlinks from the slides to those sections. If time grows short, click 

your hidden hyperlink to immediately jump to a particular section. 

This will make your presentation appear more seamless, give you 

more confidence as a presenter in control, and above all, allow you to 

cover the material you identify as most important—your keister.

The Action Settings let you 
add a URL to some text in your 
slide—or even better, to an 
invisible rectangle covering 
some text in your slide.

Rick Altman hosts the PowerPoint Live User Conference. Maria Langer is a freelance writer and helicopter pilot who 
started writing about Excel in 1992. Steve Schwartz has written over 50 books, including guides to Entourage, Office,  

and Gmail for Peachpit Press. Jake Widman has been customizing Word since version 1—and he’s not done yet.
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The power of AppleScript may well be the Mac’s best-kept secret. Apple’s exclusive scripting language can eliminate repetitive 
tasks, save you time, and perform new tricks you may not have even thought of. If you’re scared off by the idea of programming, 

don’t worry: Thousands of ready-made scripts are available for free on the Web. Here’s where to fi nd them.

APPLE
www.apple.com/applescript/apps
When in doubt, start at the mother ship. Apple’s collection includes scripts for many of Mac OS X’s 
bundled apps, and because they’re from Apple, they’re rock-solid and well-documented. A few of 
them—the Mail scripts, for instance—come preinstalled in Mac OS X’s script menu (see “Getting 
Started with Scripts,” below). Among the many gems is Create DVD From Folder, an iDVD script that 
takes a folder of images or video fi les and creates a new iDVD project from the contents, preserving 
the existing fi le hierarchy. While you’re downloading, take a moment to 
review some of the documentation that Apple provides. The example 
scripts in particular are a great way to start learning how an AppleScript 
works—the fi rst step toward writing your own.

DOUG’S APPLESCRIPTS FOR iTUNES
www.dougscripts.com/itunes
Doug Adams has created one of the most popular AppleScript-related sites on the Web, with 375 scripts for iTunes and the iPod. Scripts 
are organized into categories based on function, popularity, and date of addition. Capsule descriptions tell you exactly what each 
script does, and installation instructions are included with each download. Some of these scripts will leave you wondering how you ever 

managed your music without them. Import iPod Audio Files is the easiest and most intuitive 
method we’ve found for transferring music from an iPod into iTunes. Find Songs Without 
Artwork will set you on your way to fi lling the cover-art gaps in your music library. One 
caveat: iTunes is one of a few applications that provide their own script menus instead of 
using the system-level one. To install 
scripts, fi rst close iTunes. Then navigate 
to /user name/Library/iTunes and 
create a new folder named Scripts. Add 
scripts to this folder, and they’ll appear 
in iTunes’ script menu the next time you 
open the app.

JOE’S iPHOTO APPLESCRIPTS
www.joemaller.com/iphoto

Some of the most-useful 
scripts come straight 

from the source.

No, not that Douglas Adams—but this one can 
write just as clever a script.

A fellow named Joe Maller offers a small 
but brilliant set of scripts to better 
organize and identify fi les in your iPhoto 
library. iPhoto Date Shifter and iPhoto 
Time Shifter will instantly correct date 
and time errors caused by bad camera 
settings. The prize, however, goes to 
Reveal In Finder, which digs through 
iPhoto’s arcane folder structure to display the fi le for a selected photograph in a new Finder 
window. You can choose whether to locate the original, unaltered fi le or the edited version. 
Thanks to Joe’s excellent installation instructions, even newbies should have no problem 
using these remarkably helpful scripts. 

Field Guide to APPLESCRIPTS

An AppleScript Arsenal
By Johnathon Williams

Getting Started 
with Scripts
Before you start downloading, fi rst activate 
the script menu. In Tiger, open the AppleScript 
Utility (/Applications/AppleScript) and check 
the box next to Show Script Menu In Menu Bar; 
in earlier OS versions, run the Install Script 
Menu application found in the same folder. A 
curly-paper AppleScript icon will appear in the 
upper-right-hand corner of the menu bar. Save 
your downloaded scripts to /user name/Library/
Scripts. To activate a script, select the items that 
you want to affect (a list of fi les in the Finder, 
a playlist in iTunes, and so on), and select that 
script from the menu.

If you use iPhoto, then you should 
defi nitely pay a visit to Joe.
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JON’S LITTLE PAGE OF APPLESCRIPTS
http://homepage.mac.com/jonn8/as/index.html
What is it with the fi rst-name-only AppleScript sites? No matter; Jonathan Nathan provides an eclectic 
collection of scripts and full-blown AppleScript applications (see “When a Script Isn’t a Script,” below). 
There’s no consistent theme or function here—just a small helping of scripting goodness. Make MP3 
Audio Book converts text fi les into audiobooks using the Mac’s built-in speech 
synthesizer, while Convert Script To Markup Code is an AppleScript app that can 
format a block of AppleScript code for posting on the Web—an amazing time-
saver if you need to ask for help debugging a script in an online forum. A select 
few of Jon’s applications are shareware, but all of the scripts are free.

MAC OS X HINTS
www.macosxhints.com
This site is well-known for its collection of OS X tips and tricks, but you may 
be surprised how many of its entries contain AppleScripts. Unfortunately, 
scripts aren’t separated from other entries—but with a little digging, you’ll 
fi nd scripts that focus on less-common problems, especially involving older 

versions of common apps. For example, 
a script posted under “Find Orphaned 
Photos in iPhoto 2” assigns a unique keyword to each photo not included in an iPhoto 2 album; 
a script labeled “Sort iPhoto Album Images by Forward Date” puts an iPhoto 2 album’s contents 
in chronological order. A few scripts are printed onscreen as code (rather than offered as a 
download). To install them, copy the script code, create a new document in Script Editor 
(/Applications/AppleScript), and paste in the code. Press Compile, and save the fi le as a script. 

MAIL SCRIPTS
http://homepage.mac.com/aamann/Mail_Scripts.html
If you’re as inundated with email as we are, you need all 
the help you can get—and this collection provides 10 little 
productivity boosters for Apple Mail. Add Addresses grabs all of 
the addresses in the From, To, Cc, and Bcc fi elds from a selected 
message and adds them to Address Book. Archive Messages 
offers several options for making backups of messages and 
mailboxes. Schedule Delivery integrates with iCal to send 
messages at specifi c times (handy when you want to email the 

boss while you’re really at the ballpark). Even better, the bundle comes with its own installer. A few of 
the scripts have minor compatibility issues with Tiger and Mail 2, but nothing critical.

SCRIPTBUILDERS
www.scriptbuilders.net
Hosted by MacScripter, a massive resource for all things AppleScript, ScriptBuilders 
contains the largest collection of AppleScripts we’ve seen anywhere on the 

Web. Scripts are contributed by users 
from all over the world and organized 
into categories by both function and 
application. (For example, you can 
browse scripts that relate to email or 
those that relate only to the Eudora email 
client.) Because of the sheer number 
of scripts, documentation quality is 
hit or miss. Fortunately, MacScripter 
hosts Q&A forums, FAQs, and book 
recommendations for newbies.

Jon’s scripts have 
no unifying theme—

unless “being 
useful” is a theme. 

It takes digging, but this site hides buried treasure.

This site can help make your 
Inbox a happier place to be.

For the scripting novice, the challenge 
here is simply not to get lost.

When a Script 
Isn’t a Script
AppleScript scripts come in three 
different fl avors. Plain-Jane scripts 
are compiled code that you install as 
described in “Getting Started with 
Scripts” (p34). Droplets work like 
mini applications—to use one, simply 
save it to your desktop and drag fi les 
onto its icon. Finally, script writers 
can create full-blown applications 
in AppleScript Studio. While they’re 
written in AppleScript, they appear 
and function just like regular apps and 
come complete with their own GUIs.

Editing Scripts
To modify a script, 
open it with the Script 
Editor (/Applications/
AppleScript), make 
your changes, and 
click Compile to check 
for errors. If everything 
is correct, the Script 
Editor will color and indent your code to match the rest 
of the script. If something’s off, it will deliver a cryptic 
error message and highlight the portion of the code 
that’s causing the problem.

Johnathon Williams didn’t write 
this article—an AppleScript did.



This month, we take a look at a game with one of the 
longest titles we’ve seen in a while: Stubbs the Zombie 
in Rebel Without a Pulse. That’s not a short and easy 
name like Canon’s Optura S1 (pictured), nor is it a 
plain-vanilla name like PodPlus’s Aluminum Case—it’s 
also not a physics pun like Apple’s iPod nano Tubes. 
What else is in a name? Well, try these for next month’s 
reviews: Filemaker’s Filemaker Pro 8 Advanced, Canon’s 
PowerShot SD30 Digital Elph, Pantone’s Huey, and 
BeLight Software’s Swift Publisher.

42 Aluminum Case iPod nano case
38 Aperture post-production photo wrangler
42 CEO Card Wallet iPod nano case
44 Color LaserJet 3600n color laser printer
42 Connect & Protect iPod nano case
51 FS1 High Defi nition Earphones earbuds
54 Higher Ground Metro notebook bag
42 iPod nano Tubes iPod nano case
50 iSale eBay utility
45 iSongBook iPod companion

51 Laser Wireless Desktop Mouse mouse
48 Optura S1 digital video camera
46 Reaktor 5 software synth
54 Skooba Satchel laptop bag
49 Slim DVD±RW DVD burner
42 Small iPod Gear Pouch iPod nano case
52 Stubbs the Zombie in

Rebel Without a Pulse action game
47 Stylus C88 inkjet printer
50 Trigger Finger MIDI controller

 PLUS: 
TheHotList

  55 The best of the best 
  from recent reviews.

We’d spend our 
own hard-earned 
money on this 
product.

Compatible with 
Mac OS X or later.

Compatible with 
Mac OS 9 or earlier.
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You’ll be 
impressed.

You’ll be 
satisfied.

You’ll be 
disappointed.

You’ll be 
pissed off.

RATIN¬S

You’ll be 
blown away.
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Apple hasn’t taken a middle-of-the-
road approach with Aperture—

this app’s aimed at professional 
photographers who need a workfl ow 
organizer to aid in processing and 
organizing their photos. Apple has 
created a resource-gobbling monster; 
chances are you’ll need to upgrade your 
Mac to take full advantage of Aperture’s 
considerable features. In other words, 
Aperture isn’t for the dabbler.

Aperture is essentially an advanced 
photo viewer with some simple image-
adjustment tools bolted on—after making 
basic adjustments to images in Aperture, 
you can export them to Photoshop to 
undergo more-advanced manipulation. 
Pro photographers and serious hobbyists 
will appreciate the fact that 
Aperture works with RAW photo 
fi les, which preserve the original 
16-bit color information captured 
by a camera’s sensor. RAW fi les 

give you much more latitude than JPEGs 
for adjusting exposure, contrast, color, 
and other image aspects.

Heavy demands. Aperture lets you 
quickly sort large numbers of photos 
and save numerous versions of them. 
But unlike conventional image editors 
such as Photoshop, which change the 
actual numerical data of affected pixels, 
Aperture always preserves your original 
image fi le in what Apple calls a master 
fi le; the instructions for your crops, color 
adjustments, sharpening, and so on are 
saved in a separate database fi le. The 
advantage to this is that multiple image 
versions can be created without hogging 
storage space; you can work freely, 
creating multiple versions of images 

quickly and without getting bogged down 
with a slew of large fi les.

To apply image instructions quickly 
and to power its fl uid interface, Aperture 
demands a lot from your hardware—just 
take a look at the minimum requirements 
at the end of this review. Got one of 
those sweet 20-inch 1.6GHz iMac G5s? 
Sorry, its video card won’t cut it. Luckily, 
Apple provides an applet called Aperture 
Checker (free, www.apple.com/aperture/
specs.html) to see if your Mac makes the 
grade. And with Aperture’s expansive 
interface, you’ll need a generously sized 
display to avoid feeling cramped. You can 
get by with a 20-inch Cinema Display, but 
you’ll fi nd yourself pining for a 30-incher. 

Engaging interface. Once you meet 
the hardware criteria, you’ll be rewarded 

Aperture
POTENTIALLY POWERFUL POST-PRODUCTION PHOTO WRANGLER

Aperture’s elegant interface makes it a pleasure to sort through thousands of photos.

Viewer

Browser

Projects Panel
Adjustments Inspector

Metadata Inspector

Toolbar

Control Bar

Stacks let you group similar 
images. You can even group images 

based on their time stamps.
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with an interface that is smart, effi cient, 
and even beautiful. The Browser (which 
shows thumbnails of an entire set of 
photos) and the Viewer (which shows 
your selected photo) occupy most of the 
screen. On the left side, the Projects 
Panel lists projects, folders, albums, 
and other organizational elements. The 
Adjustments and Metadata Inspectors sit 
on the right. Images can also be viewed 
in list view, with their metadata in table 
form (though most, but not all of the 
metadata comes over when you import 
your images). This is only Aperture’s 
basic default setup; the app has many so 
different viewing confi gurations that it is 
essentially customizable.

Importing a photo into Aperture’s 
photo database is as simple as 
navigating to a folder of images and 
selecting the photos. Files and folders 
can also be dragged and dropped into 
Aperture’s Browser, imported from 
iPhoto, or downloaded directly from 
your camera. Aperture promptly makes 
master fi les from your images and 
secures them in a vault. (Remember, 
all the changes made to these fi les are 
virtual; none of your altered images 
actually exist as pixels until you export 
them as copies from your master fi le.) 
This minimal pixel baggage makes 
sifting through tons of images snappy, 
and Aperture includes options for 
comparing more than one image at a 
time in the Viewer, making it easy to 
pick the best shot from similar images. 
Photos can be grouped into Stacks, 
which show your current pick on top 
and expand and contract with a click 
of the mouse. You can select several 
images and group them into a Stack, or 
even group photos together based on a 
selectable time-stamp range. Cool.

Aperture’s Loupe is a wonderful tool 
for zooming in on your images. To see 
fi ne detail in your picture, just drag the 
circular Loupe over your photo, and it 
magnifi es just that part of the image—a 
zooming method so fast and intuitive 
that it makes you wonder why no one 
thought of it before.

You’ll also love Light Table, a viewer 
that lets you create layouts with your 

images. By dragging images to the large, 
gridded Light Table window, you can 
arrange them in any position and at any 
size or zoom level. It’s an easy, fun, and 
useful tool for envisioning how images 
will work together as a set.

As in iPhoto, you can assign star ratings 
and keywords to images, but Aperture is 
more sophisticated in that you can drag 
words from your Keyword list right onto 
your photos, not the other way around. 
Smart Albums are collections of photos 
defi ned by user-specifi ed criteria—as an 
image’s attributes change (date, keyword, 
and so on), it’s either deleted from or 
added to the Smart Album.

Limited adjustments. Aperture’s 
adjustment options for exposure, levels, 
and white balance are adequate, but 
in no way does it replace true image 
editors such as Photoshop. One basic 
nuts-and-bolts omission is a curves 
tool for adjusting an image’s densities 
in different ranges of its tonal curve (as 
opposed to uniform adjustments to the 
entire image). Aperture also provides no 
method for sampling an image’s pixel 
values—a crucial exclusion because the 
only way to judge, for example, whether 
highlights are blown out to pure white or 
actually contain some tone is to examine 
the pixel values. You’ll also have to 
do without selective changes; unlike 
Photoshop, there is no way to brighten a 
sky without brightening the entire image.

If you’ve nailed your adjustments in 
Aperture, however, they can be easily 

COMPANY: Apple
CONTACT: 
www.apple.com
PRICE: $499

REQUIREMENTS: 1.8 GHz G5 or 1.25GHz PowerBook G4; 
Mac OS 10.4.3 or later; 1GB RAM; 5GB disk space; ATI Radeon 
X600 Pro, ATI Radeon 9600, ATI Mobility Radeon 9600, nVidia 
GeForce 6600 LE, or better video card

GOOD NEWS: Sublime organizational tools and interface. 
We’re loopy over the Loupe, Light Table, and Lift And Stamp.
BAD NEWS: Pricey. Demanding system requirements. 
Image-editing shortcomings. Begs for a jumbo-size display.

applied to a large group of photos from 
the same shooting session with a simple 
drag-and-drop tool called Lift And Stamp. 
This is where Aperture’s database-driven 
method of managing fi le changes really 
pays off; doing this kind of work in 
Photoshop would be exhausting.

Image conversion and RAW export 
is as simple as choosing a destination 
and format (JPEG, TIFF, PNG, or PSD). 
Aperture’s RAW conversions are a tad 
brighter than those from Photoshop, 
with more detail in shadows and less 
in highlights. Unfortunately, converted 
images exhibit quite a bit of color 
fringing—a troubling shortcoming, 

but one that could be remedied in an 
upgrade if Apple can smooth out the 
conversion algorithms.

At the output end, Aperture is fully 
prepared to format your photos for 
contact sheets, the Web, or even into 
book form. The output looks professional 
and is at the world-class level of design 
one would expect from Apple.

The bottom line. With its elegant and 
effi cient interface and ability to easily 
create multiple versions of a photo, 
Aperture will satisfy pros who must sift 
through the hundreds of shots taken on 
an assignment. But with its limited color-
adjustment tools, it’s no replacement 
for Photoshop—and Photoshop’s own 
companion workfl ow organizer, Adobe 
Bridge, is quite adequate for browsing 
and organizing less-industrial-size 
projects.—Mark Rosenthal

A digital Light Table lets you experiment with photo layouts.
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Apple iPod nano Tubes $29
▲ Smooth silicone cover doesn’t collect lint.
▲ Click Wheel is protected, but still useable.
▲ Package includes fi ve colors (purple, pink, 

blue, green, and clear).
▼ No screen protection.

SOLID

iPod nanos sure are purty—but it seems like a gentle breeze 
can scratch the dickens out of them. Apple now includes a 
case with each nano, but it’s a boring pocket-protector -looking 

sleeve. The ideal nano case should offer maximum style, 
protection, durability, and utility at a reasonable price.
—Roman Loyola

iPod nano Cases
VITAL iPOD NANO PROTECTION

Waterfi eld Designs 
Small iPod Gear Pouch $29
▲ Made of sturdy ballistic nylon with 

soft interior lining.
▲ Holds a nano, earbuds, USB cable, 

and power adapter.
▲ Four pockets keep things separated.
▼ Like-it-or-leave-it checker pattern. 

GREAT

Speck Connect & Protect $34.95
▲ Clear silicone cover with interchangeable 

lanyard, wrist strap, and carabineer clip. 
▲ Includes a belt clip.
▲ Has a plastic screen protector with 

rubber contacts.

GREAT

PodsPlus Aluminum Case $29.99
▲ Anodized aluminum case 

comes in black or silver.
▲ Neoprene-lined interior.
▲ Screen protector.

GREAT

Marware CEO Card Wallet $24.95
▲ Leather case comes in black, tan, pink, or red.
▲ Holds business cards.
▲ Nano holster has a screen protector.
▼ Blocks dock port.

GREAT

COMPANY: Apple
CONTACT: 408-996-1010 or 
800-692-7753, www.apple.com

COMPANY: Marware
CONTACT: 954-927-2477, 
www.marware.com

COMPANY: PodsPlus
CONTACT: www.podsplus.com

COMPANY: Speck Products
CONTACT: www.speckproducts.com

COMPANY: Waterfi eld Designs
CONTACT: 415-546-1040 or 
877-546-1040, www.sfbags.com



44 REVIEWS
better living through smarter shopping

   March 200644

Hewlett-Packard’s Color LaserJet 
3600n has a lot going for it: fast 

print speeds, excellent business-
graphics quality, and an attractive price. 
If you’ve been using an inkjet printer for 
your business printing, it’s time to ditch 
that money pit and go with a color laser.

There are two versions of the 3600. We 
looked at the $699 3600n, which comes 
with one USB 2.0 port, one Fast Ethernet 
(100Base-T) port, 64MB of memory 
(upgradeable to 128MB), a 250-sheet 
adjustable media-input tray, and a 100-
sheet tray that folds out from the front 
for feeding envelopes, labels, and other 
special papers. (The printer can handle 
sizes ranging from 3-by-5-inch cards to 
8.5-by-14-inch legal paper.) The 3600dn 
adds automatic duplexing (printing on 
both sides of a page) and costs $999.

The 3600n uses four separate toner 
cartridges—cyan, magenta, yellow, and 
black—and while they ship inside the 
printer, you have to install them yourself 
by opening the 3600n, pulling out each 

toner cartridge, giving them a little 
shake to loosen up the settled toner, 
and removing each one’s protective 
seal. During the process, you’ll notice 
one somewhat 
alarming detail 
about the 3600n: 
When you open the 
printer, the delicate 
transfer unit (used 
to attach the toner 
to media) is exposed 
in all its glory. It’s 
a sight we’re not 
used to seeing in a 
laser printer—the 
printer itself says 
(via its LCD panel) 
that the transfer 
unit “can be easily 
damaged,” and a bright yellow warning 
label on the transfer unit tells you not 
to touch it. So be careful when you have 
to clear a paper jam or replace the toner 
cartridges—which, incidentally, cost 

$132.99 for black, and $129.99 each 
for cyan, magenta, and yellow. (Black 
cartridges are rated for 6,000 pages; 
colors are rated for 4,000 pages each.)

The 3600n prints 
on plain paper, but HP 
has different types of 
media available through 
its Web site. For about 
$50, you can get 50 
sheets of 8-by-11-inch 
transparencies. HP’s 
Color Laser Matte 
Brochure Paper costs 
$19.99 for 150 sheets.

Speed and image 
quality. HP rates the 
3600n at 17 pages per 
minute (ppm) for both 
monochrome and color 

printing. At the best image quality, our 
50-page Microsoft Word document 
printed at just under 17 ppm (see “Click 
to Clunk” for an explanation of how we 
gauge a printer’s speed). Printing our 
15-page, full-color Microsoft PowerPoint 
presentation, the 3600n averaged 14.77 
ppm; our two-page Microsoft Excel 
spreadsheet took a quick 20 seconds. 
Overall, the 3600n is an excellent and 
quick performer.

Text quality is as crisp and clean as 
you’d expect from a laser printer. The 
color accuracy on Excel graphs and 
PowerPoint charts is excellent, but 
there was some very minor banding in 
color gradients. Though the 3600n isn’t 
marketed as a photo-quality printer, 
printed an 8-by-10-inch photo on plain 
paper just to see what we’d get. Image 
detail was quite good, but the photo had 
a slight magenta cast to it, giving the 
people in our picture a too-rosy hue.

The bottom line. For small businesses 
and home offi ces that print over 200 
pages per week, a color laser printer 
such as the 3600n is a cheaper and 
faster way to print than an inkjet printer 
or a service bureau.—Roman Loyola

Color LaserJet 3600n
IMPRESSIVE COLOR LASER PRINTER

COMPANY: Hewlett-Packard
CONTACT: 800-752-0900, 
www.hp.com
PRICE: $699

REQUIREMENTS: USB-equipped 
Mac, Mac OS 9.1 to 9.x or 10.2 or later

GOOD NEWS: Fast. Excellent text output. Great-
looking business graphics.
BAD NEWS: Magenta shift on color photos. 
Be cautious of exposed transfer unit.

It might be 
time to ditch your 

business inkjet.

TI
P

      CLICK TO CLUNK
Ever wonder why a printer 

never seems as fast as the 

manufacturer says it is? Printer 

companies rate speed based 

only on the time it takes to 

physically print a page—they 

don’t include the processing 

required to translate the 

document into printable data. 

We measure printer speeds from 

the moment we press Print (click) 

to the moment when the page 

pops into the output tray (clunk). 
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iSongBook
ULTIMATE iPOD COMPANION

Smart design, solid construction, 
and righteous sound made Tivoli 

Audio’s iPal (  Nov/04, p50) 
our favorite portable iPod speaker; more 
of the same makes the iSongBook our 
favorite semiportable iPod companion. 
It adds a fold-out dock for your ’Pod; a 
clock radio with a big, bright, easy-to-
read display; and a second detachable 
speaker for true stereo sound.

iSongBook’s eleven buttons provide 
fi ve presets for radio stations, snooze, 
and other clock radio controls. Twin 
dials in the center adjust the volume 
and switch between AM, FM, iPod, and 
Off modes. The included remote control 
handles all of these functions (snooze 
excluded) gracefully, as well as playlist  
and album navigation.

The iSongBook sounds great. You 
can plug in an iPod, crank the volume, 
and rock the house (assuming you live 
in a cottage), or you can keep it low and 
marvel at the richly balanced subtleties 
in the midrange and high tones—though 
metalheads and hip-hoppers might fi nd 
the low end lacking. The side-mounted, 
fl ip-out dock smartly charges the iPod 
when the iSongBook is tapped into AC 
power, but not when it’s running off the 
six AA batteries (not included). 

You’ll fi nd more-portable iPod rigs 
out there, such as Altec Lansing’s 
iM7 (  Feb/06, p49), but 
the iSongBook has more convenient 
features, such as its alarm clock and 
rechargable-battery options.

The bottom line. This rig costs more 
than most iPods, so we expected the 
world of it, and the iSongBook didn’t 
disappoint. if you want the most 
versatile iPod system available, pick 
one of these up.—Niko Coucouvanis

COMPANY: Tivoli Audio
CONTACT: 877-297-9479, 
www.tivoliaudio.com
PRICE: $329.99

REQUIREMENTS: iPod with a dock 
connector. Six AA batteries.

GOOD NEWS: Sounds awesome. Looks great.
BAD NEWS: Pricey. No rechargeable batteries 
included. No snooze button on remote.

From the makers of our favorite portable iPod speaker comes the iSongBook—and it’s 
another winner.
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Reaktor is a guiding light for the 
do-it-yourself sonic set. The latest 

version extends the app in crucial ways, 
with awesome new sounds, a load of 
fresh building modules, and mounds of 
examples—expect this monster to keep 
you busy for the next 10,000 years or so.

Reaktor is a deeply programmable 
virtual-audio laboratory. You string 
together low-level programming 
modules (fi lters, oscillators, mixers, 
and logic devices) into fl owcharts called 
structures; combinations of these make 
up actual instruments. You can create 
everything from wild drum machines 
and wacky effects boxes to MIDI synths 
and real-time sampled-audio manglers. 

Reaktor works with 
any app that supports 
Audio Units, including 
GarageBand, Logic, 

Ableton Live, Digital Performer, or any 
other respectable MIDI sequencer or 
audio editor. You can also run Reaktor 
in standalone mode, which is useful for 
creating new instruments from scratch.

You’ll boggle your mind with the vast 
possibilities offered by the new Reaktor 
Core Technology, which provides a 
way for anyone to build the essential 
blocks used in complex instruments. All 
interface elements can now be skinned, 
including knobs, buttons, faders, and 
even display readouts—these major 
enhancements remove the last barriers 
that prevent aural Dr. Frankensteins 
from creating outrageous audio 
concoctions.

Library. Most Reaktor users dive 
right into its library of prefabricated 
instruments and effects, most of which 
are compelling—if not totally useful—in 

a musical context. Most musicians will 
fi nd this library to be Reaktor’s biggest 
benefi t.

 Of Reaktor’s synthesizers, 
Steampipe 2 is one of our favorites. 
It sports deliciously convincing 
digital models of air moving through 
a virtual pipe, resulting in exquisitely 
natural instruments such as cellos, 
glockenspiels, fl utes, and more. The 
Subharmonic synth will drive electronic 
musicians insane with its velvety 
smoothness.

If wild beats are your bag, Reaktor’s 
Grooveboxes (two virtual-analog 
drum synths and two sample-based 
drum and performance machines) 
are enough to keep you busy for the 
10,000 years we mentioned earlier. 
Newscool is extremely eccentric—
imagine mathematician John Horton 
Conway’s Game of Life (www.bitstorm
.org/gameofl ife) as a rhythm generator. 
Aerobic is light-years ahead of any 
Roland drum machine on the planet—
you’re likely to start hearing it in dance 
hits around the globe.

Some of Reaktor’s new sound 
generators are almost too bizarre to 
even categorize, such as the astounding 
Skrewell, an insane audio-video device 
that looks (and sounds) like it was 
recovered from a crashed UFO. The 
Vectory sampled-sound processor 
takes any sampled audio and creates 
instant beats and arpeggios; it works 
wonders on loops generated by Reaktor 
5’s Grooveboxes. The package also 
contains a gaggle of retro sequencer 
modules, the luscious Space Master 2 
reverb tool, the highly useful FatBlaster 
2 mastering limiter and compressor, and 
the positively daunting Lurker delay/
phaser/mangler, which can turn any 
incoming signal into audio magic.

The bottom line. Reaktor 5 stands at 
the top of the audio experimenter’s heap. 
It can make amazing sounds that no 
hardcore electronic musician will want to 
live without.—David Biedny

Reaktor 5
EXTRAORDINARY SOFTWARE SYNTH

Merge John Horton Conway’s Game of Life sim with Reaktor’s Newscool Groovebox, and you 
get a groovy beat box.

COMPANY: Native Instruments
CONTACT: 866-556-6487 or 323-467-5260, 
www.nativeinstruments.de
PRICE: $449

REQUIREMENTS: 1GHz 
G4, Mac OS 10.2.6 or later, 
512MB RAM, 1GB disk space

GOOD NEWS: New flexible Core architecture. Excellent additions 
to instrument and effect libraries. Beefed-up audio engine. 
BAD NEWS: Leaves no time for eating, sleeping, or other 
important activities.

ON THE
DISC

Reaktor 5



COMPANY: Epson
CONTACT: 800-463-7766, www.epson.com
PRICE: $79.95

REQUIREMENTS: USB-equipped Mac, 
Mac OS 10.2 or later

GOOD NEWS: Affordable. Smart-looking business graphics.
BAD NEWS: Mediocre text and photo prints will make you wish 
you’d spent a little more.

A t just under $80, Epson’s Stylus C88 
is a bargain printer to be reckoned 

with. Not only does it crank out text and 
charts for pennies per sheet, it also 
prints borderless photos. However, 
while the C88 performs admirably for 
its price, it may leave you wishing you’d 
spent a little more for a slightly better 
printer.

The C88 has a single 120-sheet 
media-input tray, and it can output 
borderless prints as large as 8.5 
by 11 inches or as small as 4 by 6 
inches. The printer connects 

to your Mac via USB—but cheapskate 
Epson doesn’t include a USB cable. 

The C88 uses individual cyan, 
magenta, yellow, and black DuraBrite 
Ultra ink cartridges; Epson offers 
replacement cartridges at $18.99 for 
black and $12.34 for each individual 
color. The C88 produces crisp-looking 
color charts and reproduces Web pages 
surprisingly well, even on ordinary 
inkjet paper—our prints were fairly 
clean with relatively few artifacts. As 
a home-offi ce workhorse, it does an 
admirable job with color-rich reports full 
of business graphics. We were able to 

print 16 pages of single-spaced text in 
one minute.

For text-heavy printing and photo 
prints, however, the C88 leaves 
something to be desired. We were 
disappointed in the clarity of the text 

copy, which was rife with 
blurry edges. We 
certainly don’t 
expect an inkjet 
to match the 
crispness and 
clarity of a laser 
printer for text, 

but this little bargain inkjet produced 
bargain-inkjet results. We also weren’t 
impressed with the C88’s photo prints, 
which suffered from noticeable banding 
and slight fuzziness.

The bottom line. Given its low price, 
it’s hard to bash this Stylus too brutally 
for its fl aws, but we’d gladly pay the 
extra $50 for a printer that can produce 
better-looking text and occasionally 
produce respectable photo results. But 
if your bank balance is low and all you 
need is a little color in your life, the C88 
may satisfy.—Robert Strohmeyer

Stylus C88
BUSINESS-ORIENTED INKJET PRINTER

Your bar charts 
will look beautiful, 
but your photos won’t. 



48 REVIEWS
better living through smarter shopping

   March 200648

Canon’s Optura S1 digital video 
camera is small enough to carry 

around with you to record those 
priceless, impromptu moments—no 
more settling for the mediocre video 
quality and limited recording time of 
your digital point-and-shoot still camera. 
The Optura S1’s video quality is quite 
good—provided you have adequate 
lighting when you shoot.

Measuring 2.1 by 2.9 by 4.1 inches 
and weighing about 20 ounces, the 
Optura S1 comfortably fi ts in your right 
hand. (Will lefties ever catch a break 
with camcorders?) While holding the 
camera, you access most of the Optura 
S1’s functions with your right thumb, 
including the Start/Stop button, Power 
switch, Function button, Focus button, 
Exposure lock, Set dial, and Menu 
button. Press the Menu button, and 
you have easy access to the camera’s 
options, which are listed using icons on 
the LCD display—though you’ll have to 
learn what the cryptic icons represent. A 
rectangle with a pair of black and white 

triangles, for example, leads you to all 
the options for the camera’s display—
intuitive, eh? You can breeze through 
the options using the Set dial, which you 
also press to lock in a setting.

The Optura S1 uses a good-looking 
2.5-inch widescreen LCD. If you don’t 
want to shoot in widescreen, you can 
set the camera to capture video in the 
standard 4:3 TV ratio. When you’re 
shooting, icons line the edges of the 
screen to tell you what settings you’re 

using. Once you learn what those icons 
mean, they help you quickly know 
what the Optura S1 is doing. The 
LCD backlight button that instantly 
brightens the screen is a nice touch.

The S1 also has two other thoughtful 
design features you’ll appreciate, even if 
they won’t change how you shoot video. 
The fi rst is that you load MiniDV tapes 

through the top of 
the camera—older 
Canon cameras 
load from the 
bottom, so access 
is blocked when the 
camera’s mounted 
on a tripod. The 
second feature 
is a built-in lens 
cover that opens 
and closes with a 
fl ip of the switch 
on the side of the 

camera—no more fumbling with (or 
losing) a lens cap.

Image quality. The Optura S1 has a 
2.2-megapixel CCD. According to Canon, 
4:3 video uses 1.23 megapixels of the 
CCD; widescreen mode without image 
stabilization uses 1.5 megapixels; 
and widescreen mode with image 
stabilization uses 1.38 megapixels. 
Still images (which are saved to a mini 
SD card) use all the CCD’s megapixels.

In scenes where lighting is adequate 
or bright, the Optura S1 produces 
excellent video quality with accurate 
colors, good sharpness and focus, and 
nice shadow detail. When lighting is dim, 
however, the Optura S1’s video looks 
noticeably grainy. We didn’t notice any 
image degradation when using the S1’s 
10x optical zoom, but as we expected, 
image quality quickly got fuzzy when 
we ventured into the camera’s ludicrous 
200x digital zoom. Still images aren’t as 
sharp as those from a dedicated digital 
still camera, but they’re acceptable, with 
good color and detail. 

The bottom line. It’s not the camera 
to use if you’re shooting at night, but for 
most other situations, we like the Optura 
S1.—Roman Loyola 

COMPANY: Canon
CONTACT: 800-652-2666 
or 516-328-5000, www.canon.com
PRICE: $799

REQUIREMENTS: FireWire-
equipped Mac, Mac OS 10.1.5 or later

GOOD NEWS: Compact. Easy to use. Widescreen LCD. 
Built-in lens cover.
BAD NEWS: Disappointing image quality in low-light 
environments. Unintuitive LCD icons.

Optura S1
COMPACT DIGITAL VIDEO CAMERA

Not pocket size, 
but small enough 
to keep in your 
tacky fanny pack. 

TI
P

      START EARLY, END LATE
When recording video, make sure you 

capture everything by starting your 

recording early, before the scene you 

want to shoot actually starts. Also, 

don’t end your recording exactly when 

the scene ends—let the recording go 

for a little while. This will give you 

more fl exibility when editing your 

footage. And who knows—you might 

just catch that priceless, unexpected 

moment that’ll win you a few bucks on 

America’s Funniest Home Videos.
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COMPANY: LaCie
CONTACT: 503-844-4500, 
www.lacie.com

PRICE: $179.99
REQUIREMENTS: 
USB-equipped Mac

GOOD NEWS: Compact size.
BAD NEWS: Doesn’t include Mac software.

Slim DVD±RW
LIGHTWEIGHT DVD BURNER

The Slim DVD±RW is the latest drive 
in LaCie’s line of products designed 

by F.A. Porsche. It sports a sleek, stylish 
look, and it supports double-layer DVDs 
so you can burn 8.5GB of data onto 
discs—but you’ll have to provide your 
own Mac software.

The attractive-looking drive is 
designed for portability. It measures 
5.2 by 0.75 by 6.3 inches and weighs 
11.8 ounces, an ideal size for stashing 
inside your notebook case. Your USB 
port can power the Slim DVD±RW if 
the port can provide enough juice 
(most can—but not the one on your 
keyboard); failing that, the drive comes 
with a power adapter. Unfortunately, 
the Slim DVD±RW doesn’t include any 
Mac software whatsoever; in fact, the 
packaging doesn’t even indicate Mac 

compatibility, though LaCie’s Web site 
says the drive is Mac friendly. When 
you insert a blank DVD±RW, the Mac 
recognizes it, and you can burn fi les 
through the Finder or with Roxio’s Toast 
($79.95, www.roxio.com).

We gauged the Slim DVD±RW’s speed 
by burning a 2GB video fi le onto a DVD-R 
using a dual 2.7GHz Power Mac with a 
SuperDrive. The SuperDrive’s internal 
ATA connection gave it a considerable 
advantage over the Slim DVD±RW’s 

It doesn’t burn zero to 60 in fi ve seconds, but it looks cool.

slower USB 2.0 connection. The 
SuperDrive took just under 10 minutes 
to burn and verify our fi le copy, while 
the Slim DVD±RW took 16 minutes, 25 
seconds. 

The bottom line. The Slim DVD±RW is 
a solid upgrade if you own a CD burner 
and want a DVD burner or if you want to 
replace a single-layer DVD burner—even 
with the lack of bundled Mac software. 
It’s also small enough to fi t in your 
’Book carrying case.—Roman Loyola



50 REVIEWS
better living through smarter shopping

   March 200650

Trigger Finger
BLOCK-ROCKIN’ MIDI CONTROLLER

Trigger Finger is one cool USB MIDI 
controller for any desktop drummer, 

but the fun goes far beyond virtual skins.
It’s next-to-impossible to play 

software-based drums from a Mac (or 
musical) keyboard, but Trigger Finger 
delivers an intuitive array of controls—
16 velocity-sensitive rubber pads, four 
sliders, and eight knobs that can be 
used to send out any fl avor of MIDI-
control messages. You’ll need a powered 
USB port to run Trigger Finger—USB hubs 
without added power won’t do the trick, 
and the Trigger Finger doesn’t include a 
DC power supply (even though there’s a 
port for one), nor can it run off batteries.

How does it feel? Awesome. The 
rubber pads feel just right and are a 
delight to play, with fully controllable 

response characteristics. We tested the 
Trigger Finger with Steinberg’s Groove 
Agent 2 (  Sep/05, p47) and 
Linplug’s amazing RM IV drum synth 
($149, www.linplug.com), and the 

results were rocking. It got 
even better when we mapped 

the sliders and buttons to 
various software synthesizers 

and effects built into Ableton 
Live ($499, www.ableton.com). 

We love the programmability 
and control provided by Trigger 

Finger’s bundled Enigma 
confi guration/librarian software, 
which includes a variety of 

preprogrammed templates for a 
wide selection of top audio apps.

We also used Trigger Finger with 
TroikaTronix’s Isadora (  
Apr/05, p42) to trigger video clips and 
control effects, scrub through video 
with sliders, and perform other video 
mayhem. Astounding fun ensued.

The bottom line. The Trigger Finger is 
a one-of-a-kind peripheral that’s priced 
just right.—David Biedny

COMPANY: M-Audio
CONTACT: 626-633-9050, 
www.m-audio.com
PRICE: $249.95

REQUIREMENTS: USB-equipped 
Mac, Mac OS 10.2.8 or later

GOOD NEWS: Sensitive, smooth trigger pads. Compact design. 
Easy to program.
BAD NEWS: No included DC power supply. No option for 
running off battery.

At last there’s a MIDI 
controller for the virtual drummer.

iSale
TIME-SAVING EBAY UTILITY

Mac-using eBay sellers have a 
disadvantage—eBay’s Turbo 

Lister, an essential app for anyone who 
needs to regularly sell large amounts of 
inventory, only works with PCs. That’s 
where Equinux’s iSale steps in—it brings 
Turbo Lister–like features to the Mac, so 
posting eBay auctions isn’t such a time-
consuming affair.

iSale brilliantly speeds up and 
simplifi es auction posting, allowing you 
to enter all of eBay’s listing criteria (as 
well as drag and drop photos) via a single 
panel. One click uploads the auction to 
eBay, and you can repeat the process 
countless times. iSale keeps tabs on how 
many bids your auction of old MacAddict 
magazines has garnered; it also tracks 
the total income related to your auctions. 

There is no per-listing fee to use iSale (a 
single license costs $39.95), but you still 
have to pay eBay’s fees.

iSale lets you confi gure options such 
as shipping region (international or 
domestic), the type of mailing service, 
and the cost per item. You can even add 
a shipping calculator to your listing that 
lets buyers enter their zip code to fi gure 
out shipping costs.

iSale doesn’t have a complete list 
of eBay categories (they’re always 
changing), but software updates from 
Equinux keep them current. You have 
to jump through some hoops to register 
iSale, but once you’re up and running, 
any Mac-using eBayer will fi nd a world 
of streamlined selling and, we dare say, 
cash in the attic.

The bottom line. For Mac-using eBay 
regulars, iSale is exactly the tool you’ve 
been looking for.—James Ellerbeck

COMPANY: Equinux
CONTACT: www.equinux.com
PRICE: $39.95 (single license), 
$59.95 (two licenses)

REQUIREMENTS: 
Mac OS 10.3 or later

GOOD NEWS: Convenient. Tracks auctions. Easy interface. 
Simple uploads.
BAD NEWS: Limited selling categories.

The only eBay auction app for the Mac will 
help you get rid of the junk in your attic.



It’s easy to get a snug fi t with XtremeMac’s FS1 High Defi nition Earphones, as they 
come with three different earpieces: cone-shaped silicone sleeves, foam sleeves that 

feel a lot like foam earplugs, and fl anged tips. That tight fi t helps block outside noise so 
you can better enjoy the FS1’s great sound quality.

XtremeMac uses drivers from Future Sonics (www.futuresonics.com) to produce 
the FS1’s excellent overall sound. Bass is deep and rich, but not overwhelming, while 
midtones and highs sound just right.

The FS1 phones are available in two color combinations: white and gray or black and 
gray. The only drawback we found was the cord. For some of us taller folk, the cord was 
too short to span the area between the ears and a belt-clipped iPod. 

The bottom line.  With its hefty price tag, the FS1 earbuds will appeal to serious 
sound afi cionados—but we think they’re worth the price.—Roman Loyola

Quality earphones are 
pricey, but they sound 
oh so good.

COMPANY: XtremeMac
CONTACT: 866-392-9800 or 954-385-9877, 
www.xtrememac.com

GOOD NEWS: Three different earpieces. 
Excellent audio quality. 
BAD NEWS: Expensive. Short cord.

PRICE: $149.95
REQUIREMENTS: Headphone jack

FS1 High 
Definition 
Earphones
FIRST-RATE EARBUDS

Laser Wireless Desktop Mouse
SMOOTH BUT FICKLE MOUSE

COMPANY: Targus
CONTACT: 714-765-5555 or 877-482-7487, 
www.targus.com

GOOD NEWS: Feels good. Sharp tracking.
BAD NEWS: Bad tracking on some surfaces. 
Limited button programmability.

PRICE: $59.99
REQUIREMENTS: USB-equipped Mac

The Laser Wireless Desktop Mouse is an RF mouse that’s well balanced, not too 
heavy, and not too light; its thumb-side buttons (sorry, lefties) and protruding 

thumb-rest fi t our normal-size hands comfortably. One fl aw: The scroll buttons are 
placed in line behind the scroll wheel—where we’ll never use them.

Targus claims that the 800-dpi laser tracking sensor is 20 times 
more sensitive than most  optical mice and is especially savvy on 
shiny surfaces. Indeed, this one handled our semi-shiny desktop 
surface, but on our favorite 
oriental-rug-patterned mouse 
pad, Targus’s mouse staggered 
around like a drunken toddler; 
other opticals had no problem 
with the same pad.

The bottom line. The Laser 
Wireless Desktop Mouse has 
good tracking action on some 
surfaces, and all eight of its buttons work fi ne (although with limited programmability). 
Just be prepared to have to give up your favorite mouse pad.—Niko Coucouvanis

The bigger your hands, the higher this mouse’s score.
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Stubbs the Zombie goes where 
no other game has gone before, 

putting you in the rotting shoes of a 
fl esh-eating zombie and in control 
an even larger zombie horde. If 
nothing else, Stubbs gets points 
for originality—the trouble is, while 
the high concept is fresh, the actual 
gameplay tends to get a little stale.

Stubbs takes place in a city called 
Punchbowl, which strangely blends 
future technology (robots and 
hovercars) with a squeaky-clean, 1950s 
look and feel (versions of songs like 
“Mr. Sandman” and “Lollipop” often 
play over the mayhem). Punchbowl is 
your typical utopian society. Everyone 
is happy and well-adjusted in their 
conformity—in other words, it’s a bland 
and vaguely oppressive place just 
waiting for someone to stir up trouble. 

That someone, of course, is Stubbs, 
whom you control from a third-person 
perspective. You start the game by 
literally digging yourself out of your hole, 
intent on killing everyone from hapless 
pedestrians to cops, soldiers, scientists, 
and a collection of boss characters.  

Corpse combat. You mostly engage 
in hand-to-hand combat, shuffl ing 
toward a victim and then swinging your 
arms at them. Take three or four swipes 
and you’ll kill or stun your victim, at 

which point you can eat your victim’s 
brains (complete with effectively gross 
animation and a healthy dose of blood 
effects). Your victims won’t stay dead 
for long, however; a few moments later, 
they rise and walk as zombies, ready to 
obey your orders. Whistle, and nearby 
zombies will follow your lead, or you can 
shove a zombie in the direction you want 
it to go. Your undead followers may not 
last long before being killed (again), but 

they’re defi nitely useful for swarming 
dangerous enemies and keeping some 
of the heat off of Stubbs.

Over time, Stubbs adopts some new 
attacks—he can stun nearby enemies 
by farting, and throw (and regrow) his 
own explosively toxic pancreas. More 
importantly, he can detach his forearm, 

which you can then direct along the 
ground or up walls, and then have it 
pounce on an unsuspecting victim. 
Doing so lets you possess and control 
the poor guy—you can force a soldier to 
gun down his comrades, for example, or 
use someone to unlock a door.

Zombied out. If this sounds fun, it is—
but only up to a point. After a couple of 
hours, the gameplay becomes repetitive 
and not especially challenging. One 
problem is that Stubbs moves slowly 
(well, he is dead), so there aren’t many 
chances to dodge or use dexterity. 
Another hitch is that you mostly attack at 
close range, without having to aim much. 
The game feels simplistic and sluggish 
compared to other third-person action 
games that have you running, jumping, 
ducking, and shooting.

The level design is also quite linear. 
You usually move along a prescribed 
path from point A to point B, so you 
don’t have much choice about where to 
go. Finally, the game doesn’t last long—
you can fi nish it in about six hours.

The bottom line. The be-the-zombie 
concept and sense of humor make 
Stubbs a fun novelty. But if you love 
action gameplay that gets your blood 
pumping and rewards your skill, then 
you’ll probably wish it showed a little 
more life.—Helmut Kobler

Stubbs the Zombie in 
Rebel Without a Pulse
ORIGINAL BUT MONOTONOUS ACTION GAME

COMPANY: Aspyr
CONTACT: www.aspyr.com
PRICE: $49.99

REQUIREMENTS: 1.2 GHz G4, Mac 
OS 10.3.9 or later, 256MB RAM, 64MB 
ATI Radeon 9500 or nVidia GeForce 
FX5200 or better, 4GB disk space

GOOD NEWS: Original premise. Lots of humor. 
Polished graphics and sound.
BAD NEWS: Repetitive gameplay. Occasionally choppy 
framerate. Short play time.

The framerate can get choppy on middle-
of-the-road Macs.

Stubbs is heavy 
on humor and 
style—but not 
on gameplay.
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RoadWired’s spiffy Skooba Satchel 
is stylish and tough, and it 

owes its protective qualities to 
bubble wrap—sort of. Think of the 
Air Square liner in the laptop pocket 
as bubble wrap on ’roids—scores of 
unpoppable (yes, we tried to pop 
’em; how can anyone not try to pop 
bubble wrap?) air-fi lled pockets that 
cushion your up-to-17-inch ’Book. 
Replete with gadget-size pockets (but 
no ’Pod-specifi c pocket, unfortunately), 
lined dividers, and even a zip-away beverage holder, the  
Satchel packs plenty of good stuff into its slim profi le.

The bottom line. The Skooba Satchel is a sturdy, sporty 
notebook bag into which you can stash a whole lot.
—Michael J. Shapiro

Skooba Satchel
ROOMY NOTEBOOK BAG

COMPANY: RoadWired
CONTACT: 877-435-5679, 
www.roadwired.com

PRICE: $99.95
REQUIREMENTS: PowerBook or iBook

GOOD NEWS: Rugged. Deceptively spacious. 
Available in pink (aka the new black).
BAD NEWS: No iPod-specific pocket.

Includes an air 
pocket for your ’Book.

When gracefully ensconced in the Higher Ground Metro, 
your 15- or 12-inch iBook or PowerBook never has to 

leave its case, even when you need to use it. You just unzip 
the Metro’s padded side panel, and fl ip it down; your ’Book 
rests in the panel, which has riser pads to let air circulate 
through. The only problem: In some of the trendier coffee 
shops we frequent, the tables are barely big enough for 
the laptop-laden Metro and our nonfat-soy-milk-no-foam-
double-shot latte. Quite the conundrum.

The bottom line. The Higher Ground 
Metro is a sturdy, stylish bag with a 
whole lotta pockets.—Michelle Victoria

Higher Ground Metro
FASHIONABLE LAPTOP BAG

Protective and 
roomy for 
the urban 
fashionista.

COMPANY: Shaun Jackson Design
CONTACT: www.laptopoffice.com
PRICE: $79.95

GOOD NEWS: Looks hip without being too 
trendy. Lots of pockets.
BAD NEWS:  Might be too big for the tables 
at your local coffee shop.

REQUIREMENTS: 
15-inch or smaller ’Book
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ACCESSORIES   

Epson P-2000 $499.99 Aug/05, p46 This media player’s gorgeous display is a photographer’s dream.

Palm Treo 650 $659.00 May/05, p44 It’s the best PDA-and-cell-phone combination on the market.

Palm TX handheld $299.00 Feb/06, p40 This PDA just might have enough oomph to replace your ’Book.

AUDIO & VIDEO   

Altec Lansing inMotion iM7 $249.95 Feb/06, p49 This boomer is our hands-down favorite iPod speaker stand.

iHome iH5 $129.95 Jan/06, p57 This great-sounding clock radio includes a dock for your iPod. 

Sonos Digital Music System $1,199.00 Jun/05, p36 Pricey, yes—but it’s the best music streamer you can buy.

DIGITAL CAMERAS   

Canon EOS Digital Rebel XT $999.00 Sep/05, p44 A compelling reason to switch from your old point-and-shoot.

Nikon D70 Digital SLR $1,299.00 Jul/04, p50 It’s as close to perfect as any digital SLR camera we’ve seen.

PRINTERS   

Brother International HL-2070N $169.99 Sep/05, p53 This affordable laser printer is great for text, charts, and graphs.

Canon Pixma iP6600D $199.99 Feb/06, p47 Fast and affordable, this printer is ideal for amateur photogs.

Canon Pixma MP780 $249.00 Dec/05, p48 Scan, fax, and print both business docs and photos beautifully.

Epson Stylus Photo R1800 $549.00 Sep/05, p43 If you’re a serious photog, this midrange inkjet is a bargain.

Epson Stylus Photo R2400 $849.99 Dec/05, p44 The successor to Epson’s great Stylus Photo 2200 is even better.

Konica Minolta magicolor 2430 DL $499.00 Oct/05, p44 Want fast photo-quality laser images at a good price? Here y’go.

STORAGE   

ILY SlimDVDup $699.00 Apr/05, p45 Quickly duplicate CDs and DVDs without tying up your Mac.

Newer Technology miniStack 400GB $329.99 Nov/05, p42 This speedy Mac mini–style drive is also a FireWire and USB hub.

OWC Mercury Elite-AL Pro 400GB $359.99 Nov/05, p50 Speed, a great case, FireWire 800/400, and USB 2.0—good stuff.

WiebeTech TrayDock $169.95 May/05, p49 This slick hard-drive enclosure provides the ultimate in fl exibility.

AUDIO   

Apple Soundtrack Pro $299.00 Sep/05, p40 This is one of our favorite components in the Final Cut Studio suite.

Arturia ARP2600 V $310.00 Nov/05, p52 The legendary analog synth is back, now digital and polyphonic.

Bias SoundSoap 2 $99.00 Jul/05, p37 SoundSoap Pro’s little brother is a capable audio cleaner.

Native Instruments Absynth 3 $339.00 Sep/05, p45 This surreal electronic synth has great surround-sound support.

Native Instruments Kontakt 2 $449.00 Jan/06, p43 Native Instruments scores again with this superb software sampler.

GAMES   

Aspyr Doom 3 $49.99 Jun/05, p48 Hellish, scary fun—but not for the faint of hardware.

Aspyr The Sims 2 $49.99 Oct/05, p36 The sequel to the megapopular simulation is loaded with new goodies.

Aspyr Tiger Woods PGA Tour 2005 $39.95 Jan/06, p46 Not just a great golf game, but a great game, period.

Blizzard World of Warcraft $49.99 Apr/05, p40 This rich online role-playing game is more addictive than nicotine.

MacSoft Close Combat: First to Fight $39.99 Sep/05, p38 One of the most intense squad-based tactical shooters around.

GRAPHICS & LAYOUT   

Adobe InCopy CS2 $249.00 Aug/05, p42 This workfl ow app amps up any InDesign team’s productivity.

Adobe InDesign CS2 $699.00 Aug/05, p40 A strong upgrade to the world’s most feature-rich layout app.

Adobe Photoshop CS2 $649.00 Aug/05, p38 A raft of new photo-focused features makes this upgrade rock.

Adobe Photoshop Elements 3.0 $89.99 Mar/05, p36 Adobe’s affordable image editor gets a signifi cant upgrade.

Corel Painter IX $429.00 Feb/05, p38 This natural-media champ is now faster and more capable. 

Freeverse Comic Life Deluxe Edition $29.95 Feb/06, p50 Turn your photos into colorful comics with this fun and easy app.

Macromedia Dreamweaver 8 $399.00 Dec/05, p42 The best Web-authoring tool you can buy, be you pro or newbie.

PixelGenius PhotoKit $49.95 Nov/05, p48 A great photo fi xer, especially if you shoot in black-and-white.

PixelGenius PhotoKit Color $99.95 Dec/05, p52 Take your color photos to new heights with this pro plug-in pack.

PRODUCTIVITY & UTILITIES   

Bare Bones Software BBEdit 8.0 $199.00 Jan/05, p36 By far the most powerful text editor money can buy.

Microsoft Offi ce 2004 $399.00 Aug/04, p42 Enhancements to every app add up to a worthy upgrade.

VIDEO & ANIMATION   
Apple Final Cut Express HD $299.00 Jul/05, p32 This low-cost editor adds HDV support, Soundtrack, and LiveType.

Apple Final Cut Pro 5 $999.00 Sep/05, p36 If you want to work with HD or multicamera editing, get this now.

Macromedia Flash Professional 8 $699.00 Jan/06, p42 Media designers should run, not walk, to get this potent update.

the List SHOPPIN¬?HERE’S WHAT WE RECOMMENDHot
THE BEST OF THE BEST FROM RECENT REVIEWS

Comic Life 
Deluxe Edition
Digital artist Gil Loyola calls this 
colorful comic creator “fun, easy, 
and extremely addicting.”

Canon Pixma 
iP6600D
Imaging pro Rick Oldano calls this LCD-
equipped beauty “an ideal printer for 
the amateur digital 
photographer.”

TX 
handheld
According to PDA 
princess Cathy Lu, the 
TX is “a feature-rich, 
viable alternative to 
your ’Book.”

inMotion iM7
MacAddict Reviews Editor Roman 
Loyola calls this powerful iPod 
speaker stand “just too good to 
pass up.”
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FIX COMMAND-F
Every time I press Command-F to search 
in Mac OS 10.4, the search criteria 
always defaults to Kind and Last 
Searched. Can’t I change this?
You can leave those extra-criteria 
fi elds empty and they won’t affect 

because inquiring minds have the right to be inspired

your results; you can also hide them 
by selecting Hide Search Criteria from 
the Action menu. Actually changing the 
default criteria is trickier—see page 62 
for details.

SENTIMENTAL VALUE
I have an old iMac. What’s it worth?
Value is in the eye of the beholder, 
especially where older Macs are 
concerned. Keep the proverbial grain 
of salt handy and check www.everymac
.com for a ballpark price. Then check 
www.ebay.com to see what people are 
actually paying in the wild.

SHORT NAME
Can I change the Short Name of my 
Mac OS X user account?
Although changing your long Name is 
simply a matter of typing a new one 
in System Preferences > Accounts, 
it’s not as easy to change your Short 

Name. One way is to create a new 
account and transfer all the old data 
to the new account. Apple provides 
an article that explains the entire 
process at http://docs.info.apple
.com/article.html?artnum=106824. 

The other method involves lots of 
typing in the Terminal—it’s tricky, time-
consuming, and potentially system-
damaging. Developers Dan Frakes and 
James Bucanek, however, have put 
a friendly face on the process with a 
utility called ChangeShortName (free, 

on the Disc, www
.macosxpowertools
.com). Save yourself 
the headache.

MENU TIME
Is there a way to show both the date 
and time in the menu bar in Mac OS 
10.4 (Tiger)?
There sure is, and it works in both Mac 
OS 10.3 and 10.4. First, fi re up the 
Terminal (/Applications/Utilities). At 
the prompt, type defaults write -g 
AppleICUTimeFormatStrings
-dict-add 2 “MMMM d, y 
hh’:’mm’:’ss’ ‘a”. Press Return, and 
then type killall SystemUIServer. 
Now press Return again, and your menu 
bar will disappear—click anywhere on 
your desktop to reload it. This setting 
only affects your user account; other 
users on the Mac will not see the 
change. To restore your menu bar to 
normal, repeat the process, omitting the 
MMMM d, y part in the fi rst Terminal 
command, like so: defaults write 
-g AppleICUTimeFormatStrings 

-dict-add 2 “hh’:’mm’:’ss’ ‘a”. 
Didn’t know the Terminal could control 
space and time, did ya?

TRANSPLANT
I want to buy a new Mac, but I’ve got 
years of crap accumulated on my old 
one. Is there an easy way to get it all 
onto the new machine?
If you haven’t upgraded to a new Mac 
in the past few years, you’re in for a 
real treat—beyond the obvious treat 
of having a new Mac. Migrating your 
applications, passwords, preferences, 
documents, network settings, and 
other easy-to-forget items to a new 
Mac sounds daunting, but the Tiger 
Setup Assistant includes a Migration 
Assistant that handles the entire 
process of transplanting your OS and all 
of your fi les. If your old Mac has built-
in FireWire and Mac OS 10.1 or later 
installed, all you need to bring to the 
party is a standard FireWire cable—and, 
of course, your new Mac. When you fi rst 
fi re up the new Mac (or freshly install 
the Mac OS), the Assistant will prompt 
you to connect the Macs and walk you 
through the easy-as-pie migration.

FREE-RANGE DVD
How can I watch European DVDs 
on my Mac?
Since DVDs are encoded for certain 
geographical regions, your Mac will let 
you watch other regions’ DVDs up to fi ve 
times before it makes you choose your 
permanent region. You can skirt this 
limitation with VLC Media Player (free, on 
the Disc, www.videolan.org/vlc), which 
plays DVDs on your Mac regardless of 

SAFETY FIRST
Do I really have to shut down my 
Mac before adding more RAM or 
another internal hard drive?
Absolutely! Always shut down your Mac 
before you go messing with its insides, 
or you risk frying a component, your 
whole Mac, or even yourself.

If only changing your attitude were so simple.
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Get more out of your Mac’s menu bar.

Ignoring extra search criteria is easier 
than changing them. 

ON THE
DISC

ChangeShortName
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HOW TO 57No whining—
anyone 
can do this!

It’ll take some 
effort, but you 
can do it.

This stuff’s 
for the pros.

DIFFICULTY
RATINGS 

    MIND YOUR MAIL
Is there a way to keep a copy of my mail 
on my mail server using Mac OS X’s Mail 
application?
Sure; go to Mail > Preferences, and 
click the Accounts icon at the top 
of the window. If you have multiple 
email accounts, select one from the 
Accounts list, click the Advanced tab, 
and uncheck Remove Copy From Server 
After Retrieving A Message. If you’re 
afraid that’ll cause too much clutter in 
the long term, you could check the box 
and choose a time frame from the pull-
down menu—When Moved From Inbox, 

Submit technical questions 
or helpful tips directly 

via email (askus@macaddict.com) or c/o 
MacAddict, 4000 Shoreline Court., Ste. 
400, South San Francisco, CA 94080.

so, hold down C while restarting). When 
the Installer launches, choose Utilities 
> Disk Utility; both your internal and 
external drive should appear in the list 
of volumes. Click your internal drive, 
and then click the Restore tab. In the 
Restore pane, drag your internal drive to 
the Source fi eld and your external drive 
to the Destination fi eld. Be sure there’s 
plenty of room on the Destination drive; 
if you check the Erase Destination box, 
everything on the Destination drive will 
be erased before copying begins. Click 
Restore, and let Disk Utility do its thing.

for example, will keep your mail on the 
server until you decide to delete it from 
your Mail inbox.

the DVD’s designated region. To make 
sure that Apple’s DVD Player doesn’t 
automatically launch when you insert 
a DVD, open System Preferences and 
select CDs & DVDs. Select Open Other 
Application from the When You Insert A 

Video DVD pull-down menu, and browse 
to VLC Media Player. As a bonus, VLC lets 

you take screenshots 
of DVDs—something 
Apple’s player doesn’t 
let you do.

MEET STYLE SHEETS
What is CSS, and why should I care?
CSS stands for Cascading Style Sheet, 
and it’s useful for adding styles to 
Web pages. Typically, Web pages are 
built with HTML (Hypertext Markup 
Language) and use basic formatting to 
determine the way pages look. CSS is 
used in addition to HTML to describe 
how elements and content on a page 
are to be presented; the benefi t is 
that you can easily change the look or 
style of multiple pages of a Web site 
at once—a potentially huge time-saver 
if you’re a Web developer. To see the 
power of CSS in action, check out www
.csszengarden.com—and pay extra-
close attention if you plan on pursuing 
a career in Web design one day.

CLONE TO THE BONE
Can I make make an exact copy of my 
internal hard drive on an external one?
The easiest way to do this without 
purchasing extra software is to use 
Apple’s Disk Utility. Boot from your 
Mac’s OS-installation CD or DVD (to do 

Don’t hate the player. Bring your own.

ON THE
DISC

VLC Media Player

UNIX UNIVERSITY

Buz Zoller is a graphic designer living in 
Florida. He has been a devoted Mac 

user for over 10 years and has worked for 
both Apple and Power Computing.

HOUSEKEEPING
You guys are always crowing about Cocktail and the Unix 
maintenance scripts it automates. How did folks handle this 
stuff before Cocktail and similar front ends to Unix maintenance? 
Mac OS X’s Unixy core and all of its 
ancillary system fi les rely on special 
maintenance routines that perform 
important housekeeping tasks. Mac 
OS X runs these maintenance routines 
automatically for you in the wee hours, 
rotating and deleting old log fi les, 
clearing out disk caches and temporary 
fi les, updating system prebindings, 
and more—you know, stuff you’d do 
on weekends if you didn’t have a life. 
However, if you turn your Mac off or 
put it to sleep at night, this important 
maintenance work doesn’t happen. 
While neglected log fi les and caches 

probably won’t completely cripple your 
Mac, you’ll eventually start to notice 
general sluggishness, a loss of disk 
space, and possibly worse symptoms 
of your negligent hygiene. 

If you think your Mac is suffering from 
maintenance neglect, be a real Unix 
jock and launch these maintenance 
routines manually. To run all of OS X’s 
regular maintenance scripts, launch the 
Terminal. Type sudo periodic daily 
weekly monthly and press Return. 
Enter your password at the prompt. Note 
that you can omit any of the time-frame 
options, so if you only want to run the 

weekly routines, for example, 
type sudo periodic weekly and 
press Return. To fi nd out when 
these routines were last run, type 
ls -al /var/log/*.out and 
press Return.

Mac OS X errs on the side 
of safety when it comes to 
archiving log fi les.

Packrats, rejoice! Your spam is safe.
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revive dull photos in iPhoto

Ease Into It1 If you’re completely new to iPhoto, first launch it  
(/Applications), select File > Add To Library (Command-O), 

and then navigate to a photo on your Mac. Now select iPhoto >  
Preferences. In the General pane, set the Double-Click Photo 
option to Changes To Edit View, and close the dialog. Find the 
photo you want to fix in iPhoto’s Library and double-click it to enter 
Edit mode. Click the Enhance button: It usually does a good job of 
adding snap to photos by increasing contrast, saturating color, and 

removing gray tones. In our 
case, however, it removed 
some of the gray and added 
a bit of contrast, but still left 
our photo a little flat.

The one-click Enhance button 
can do wonders—but we can 
do better.

iPhoto’s histogram can help 
you breathe life back into 

plain or muddy photos.

Plan B: Enhance Manually2 To see just what Enhance did, hold down Control to 
temporarily revert the photo to its original state. If your 

photo still needs some tuning (as ours does), press Command-
Z to undo the enhancement. Now click the Adjust button to 
open up iPhoto’s Advanced Editing Dashboard. Don’t see an 
Adjust button? iPhoto might be too big for your display—access 
missing tools by clicking the double-right-arrow icon in the 
lower left.

If your Adjust icon is missing, click the double arrow in the lower 
right to find the command in a menu.

Hello, Histogram3 The histogram (the red, green, and blue mountain range 
near the bottom of the Advanced Editing Dashboard) is 

the CAT scan of digital photography: It provides a graphical view 
of the image’s brightness and color 
range at the per-pixel level—dark to 
the left, bright to the right. A general 
rule of thumb is that the histogram’s 
peaks should be centered or slightly 
to the right-hand side of the graph. 
Notice that in the screenshot, our 
peaks are—like Ted Kennedy—a  
little left of center.

The Advanced Editing Dashboard 
is your manual interface to the 
Enhance button’s one-click fix.
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Mac OS 10.3.4 or later

iPhoto 5 ($79, part of iLife ’05, www.apple.com)

A photo that needs a little TLC

WHAT YOU NEED

W
hile iPhoto was once little more than 
a handy photo library, it has since 
evolved into a nifty image-editing tool. 
Here’s how to tap iPhoto 5’s advanced 

image-editing tools to make mucked-up photos look 
better—without that artificial aftertaste that can sour 
retouched images.

Revive Dull Photos in iPhoto
by Kevin Wolfe

Keep ’Em Saturated4 Start with the Saturation slider; move it to the right to 
about 90 percent to enrich the color and remove some 

gray. Check the histogram again—the mountains have moved 
even more to the left, and the image is considerably darker. 

Although 
90-percent 
saturation 
may seem 
excessive, 

don’t worry—
we’ll tone it 
down later.  

BEFORE

AFTER



Kevin Wolfe has been using iPhoto since version 1 and is 
the author of the e-book Serious Editing in iPhoto 5 (www 

.booksthatdontgobad.com).

Expose Yourself5 For many photos, you can just drag the Exposure slider 
to the right until the peaks are more centered. Our 

problem is that we have lower peaks on the right side that we 
don’t want to turn into high cliffs on the edge of the histogram. 
(Cliffs show that color is being lost to highlights.) Drag the 
Exposure slider right until it’s at about 13 percent.

On a less-mucked-
up photo, tweaking 
the Exposure can 
do the trick.

Hijack the Histogram6 The Levels slider below the histogram lets you manually 
set the black and white points, simultaneously increasing 

contrast and smoothing the tonal range. Click and drag to adjust 
your brightness extremes, and note that a little goes a long way; 
we only took off a percent or two on each side. Press and hold 
the Control key to check your changes against the original. The 
scene should now look cooler and clearer.

Like God, you get to define black and white.

Sharpen It7 Muddy images like our sample generally benefit from 
a little sharpening. Just remember that sharpening 

should always be the last step of your photo-demucking 
endeavors, since making further adjustments usually reblurs 
anything you’ve previously sharpened. Drag the Sharpness 
slider right to 50 percent to bring out a little more detail. Drag 
the Zoom 
slider (in the 
lower-right 
corner) to get 
a closer look.

Careful with 
the Sharpness 

slider—using 
it incorrectly is 
worse than not 

using it at all.

Exit to Edit8 When your image looks suitably fabulous, iPhoto 
provides several ways to leave the Edit interface and 

return to browsing the Library. Since you set the Double-Click 
option in step 1, double-clicking your image in Edit mode will 
save your changes and load iPhoto’s Library. Other escapes 
from Edit: Click another image’s thumbnail in the upper pane; 
click the Previous or Next arrow at the bottom of the window; 
click Done; or click a different album or slideshow in the 
Source list.

Warning: Leaving Edit mode automatically saves your changes.

Histograms can look complicated, but they’re not that 
hard to read once you’re used to them. Dark colors 
are on the left side, and light colors are on the right. 
The mountain height shows the number of pixels in 
the shade of a color. The left Levels slider turns dark 
colors black, and the right Levels slider turns light 
colors white. If the sliders meet in the middle, you get 
monochrome, so go easy.

TOOL SCHOOL 

Don’t fear the histogram—master it.
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Charge It
LiIon cells in ’Books and ’Pods charge in two stages. Stage one 
is a fast charge at constant amperage and steadily increasing 
voltage. When the battery reaches a 70- to 80-percent charge, 
the second stage begins, gradually decreasing the current 
applied to the battery while maintaining constant voltage until 
the battery is fully charged. This second stage is called the 
trickle, or topping-off charge, and it takes two to three times 
as long as stage one. Contrary to popular belief, it doesn’t 
matter whether you completely drain and completely charge 
the battery every cycle, or grab a few minutes of charge time 
whenever you can—although the latter practice will eventually 
make your reported battery-charge and remaining-life times 
inaccurate.

Coddle your battery, and it will serve you well.

60 HOW TO
baby your battery
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Replace It
Apple will sell you a new battery for any of its current ’Books 
($129, www.apple.com), but the company no longer sells 
batteries for most of its older models. MadsonLine (www 
.madsonline.com) and BTI (www.batterytech.com) make 
replacements, and some retailers refurbish and resell used 
batteries (full disclosure: Kyle’s company, PB FixIt, is one such 
retailer—Ed.). The main concern is age: It’s best to buy a recently 
manufactured battery and not just a “new” battery that was 
made five years ago and has never been used.

Just because a battery is rechargeable doesn’t mean  
it’ll last forever.

Gauge It
Battery capacity is expressed in milliamp-hours (mAh)—our 15-
inch PowerBook started out with 4,400mAh, so its claimed 4.5-
hour battery life tells us that the ’Book draws about 1,000mA per 
hour. You can determine your battery’s remaining capacity with 
third-party utilities such as XBattery ($15, on the Disc, www 
.kezer.net) or iBatt ($15, on the Disc, http://raynersoftware 

.com), or you can use the Terminal (/Applications/Utilities). Type 
ioreg -l | grep Capacity and press Return. If you don’t see a 
longish result like in our screenshot, drag the Terminal window’s 
lower-right corner to fill your screen. The first item, Capacity, is 
your battery’s current capacity in milliamp-hours; the final item, 
AbsoluteMaxCapacity, lists the battery’s original capacity.

Use It or Lose It
If you store your LiIon battery with a full charge, it’ll irreversibly 
lose about 20 percent of its charge capacity per year. If you aren’t 
going to use your ’Book for a while, leave your battery partially 
charged (40 to 50 percent). Even then, LiIon cells lose capacity 
over time—but they lose capacity more slowly at cool (not 
freezing) temperatures. Think about that when you’re choosing 
whether to store your old iBook in the basement or the attic.

You don’t swim with a full stomach, and you don’t store  
a ’Book with a full battery.

ON THE
DISC

iBatt, Xbattery

PowerBook, iBook, or iPod

A thirst for knowledge

WHAT YOU NEED

L
ithium-ion batteries (LiIon for short) are amazing 
creatures, packing a much higher energy density than 
the nickel-based cells of yore. What you do on your 
PowerBook or iBook is your own 

business, but if you follow these tips, you 
can do it for longer. Bonus: Most of this info 
holds true for iPod batteries as well.

Baby Your Battery
by Kyle Wiens
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Just when you thought you’d escaped the bell curve. 

For reasons unknown, the Terminal cuts off the results at the window’s edge—so start with a wide window.



Safety First1 It’s downright foolhardy to hack plist or other system 
files without backing them up first. Navigate to /System/

Library/CoreServices/Finder.app (or simply Finder if you have 
Show All File Extensions unchecked in Finder > Preferences > 
Advanced). Control-click Finder.app and select Show Package 
Contents from the pop-up menu. Dig into /Contents/Resources 
and locate default_smart.plist. Tiger’s Smart Folders are merely 
saved search strings, and this plist file defines the default state 
of a new Smart Folder—or a Command-F search (which becomes 
a Smart Folder after you press the Find window’s Save button). 
Option-drag the plist file to your desktop to make a copy.

Back up, Jack, for the good of your Mac.

Changing system defaults (such as search criteria in Search windows) 
isn’t as scary as it sounds—provided you follow the rules.

Unlock It2 The Finder and all of its packaged files are crucial to 
the system, so they’re locked down tighter than Apple 

HQ. To unlock the plist file for editing, you first need to give 
yourself permission. Click the file to highlight it, and choose 
File > Get Info (Command-I); at the bottom of the Info window, 
click the disclosure triangle labeled Ownership & Permissions. 

Click the lock icon, and change 
the name in the Owner pull-
down menu from System to 
your user name, and enter an 
administrator password at the 
prompt. The Access pull-down 
menu should automatically 
change to Read & Write—if it 
doesn’t, change it manually.

Permission is half  
the law ... right?

Hack It3 If you installed the Xcode Developer Tools with Tiger, 
simply double-click default_smart.plist to open it 

in Apple’s Plist Editor; otherwise, open the file in TextEdit 
(/Applications) to edit it as raw text. Now it’s time to replace 
Find’s two default criteria (Kind and Last Opened) with one: 
Name Contains. Find the SearchCriteria key up near the top; 
notice the two FXSliceKind keys below it. Delete the first key 

(everything from <dict> to 
</dict>). In the second key, 
change Slsv to Snam, and 
change DA** to S:**. Now 
press Command-S to save the 
changes, close the file, and 
start searching your way.

We actually prefer a text editor 
to Plist Editor for editing plists.

Go Criteria Crazy4 You can set your Find default to include as many extra 
criteria as you wish; to find out how to change the keys 

in the plist file, simply create and save 
a Smart Folder. Press Command-F, and 
select the criteria you want for your new 
default; type something (it doesn’t matter 
what) into one of the search fields to 
activate the Save button. Press the Save 
button, and save the Smart Folder to your 
desktop. Drag the Smart Folder icon into 
TextEdit—the Smart Folder will open just 
like default_smart.plist did, revealing all 
of the FXSliceKind keys for you to cut and 
paste into the default_smart.plist file.

Paste these keys into your plist to make 
them part of the default search criteria.

62 HOW TO
change unchangeable system settings
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Mac OS 10.4 or later

WHAT YOU NEED

 H
istorically, the Mac OS has given you easy ways 
to change most of its basic default settings— 
which printer to use, how windows display, 
whether you’re warned when you empty your 

Trash, and so on. But in the brave new world of OS X, 
some settings are inexplicably buried in plist files. Here’s 
how to hack those plist files, using Tiger’s unchangeable 
Command-F default search criteria as an example.

Change Unchangeable System Settings
by Niko Coucouvanis
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HOW TO
back that Mac up

Plan Ahead1 Don’t wait until you need to use Backup to free up disk 
space; the app requires that you have enough free space 

on your hard drive to temporarily stash the files you’re backing 
up—filling up a 4.7GB DVD with your hobbit-porn collection, for 
example, requires 4.7GB of free space on your hard drive. In a 
pinch, you can do your backup to multiple CDs instead—that 
way you only need one CD’s worth of disk space (typically 
650MB or 700MB), which Backup will reuse for each chunk 
of the backup. You pay the difference in time spent swapping 
blank CDs—not to mention the headache of keeping track of a 
majorly segmented backup archive.

You’ll need to unlock 
your Keychain—it’s 
up to you whether 
to Allow Once or 
Always Allow.

Know Thy Backups2 Backup 3 can create two kinds of backup files: Full 
backups and Incremental backups. As you might 

guess, the first time you execute a Backup Plan, Backup 
automatically creates a Full backup; subsequent backups 
are of the Incremental variety and contain only files that 
have changed since the previous backup. For even better 
incrementality, Backup saves the two most recent versions 
of files that have changed. If you’re still annoyed that Backup 
uses boatloads of disk space to work its magic, take heart: 
Incremental backups are way smaller, and thus require way 
less disk space than Full backups.

The first backup 
is automatically a 
Full one; you can 
force a new Full 
backup any time.

It’s wise to verify your backup before you actually  
need it. After creating your first Full backup, pretend 

you’ve lost everything—use a different Mac for extra realism. 
First, find the Backup file (for example, Purchased Music -  
2005.12.15-19.21.37.552.FullBackup) on your hard drive, iDisk, 
or optical disc. Whatever the destination, Backup creates a 

Backups folder at the root level and 
stashes your backups there (unless 
you designate a different location). 
Double-click the backup file to open 
the associated Plan. Check the 
Restore To An Alternate Location 
box, choose a destination, and 
press Restore Selection. Backup 
recreates the file path for you.

Backup even reminds you where your 
replacement data goes.

Dry Run3 If you’re a rabid backer-upper, your Backups folder will 
fill up fast. To weed out the excess, launch Backup, 

highlight one of the Plans in your Backup window, and select 
Plan > Full Backup to create a new master backup for that 
specific Plan. This restarts this Backup Plan from scratch, so 
you can delete all of the Plan’s other backup files. Obviously, 
if you back up multiple Plans to the same Backups folder, be 
careful when rotating your backups.

Micromanage4

In a sea of backup files, it’s easy to grab the wrong one.

All subsequent 
auto-backups are 
of the smaller, 
Incremental 
variety.

Back That Mac Up
by Niko Coucouvanis
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W
e’re relentless about telling you to back up your files and 
Mac OS X settings—and now that Apple’s released Backup 
3 (free with .Mac account or free 60-day trial, www.mac 
.com), you’ve got no excuse not to. Here’s how to back up 

smartly—just be aware that Backup doesn’t make bootable backups.
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Backup software that’s user-friendly and useful?  
Must be Apple’s.

Backup 3.0.1 (free with trial or full .Mac account, www.mac.com)

Mac OS 10.3.9 or 10.4.2 or later

.Mac account (optional, $99 per year, www.mac.com)

WHAT YOU NEED
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21% Current apps 
will run dog-slow in 
Rossetta.

26% My current 
Mac will be consigned 
to the dustbin of 
history.

JUDGE NOT LEST 
YE BE JUDGED
I appreciated Niko’s “See 
Who’s Sharing iTunes” 
how-to (Jan/06, p65), but I 
recently discovered there’s 

a Dashboard widget for 
Tiger that does the same 
thing—it’s called RendezWho 
(free, www.mscape.com). 
I’ve loaded my iTunes library 
with tunes by American Idol 
fi nalist Justin Guarini just 
so I know which coworkers 
not to make eye contact with 
anymore.—Louis Buckman
Interesting strategy, but have 
you considered how many 
coworkers will want to avoid 
eye contact with you for the 
very same reason?—Max

THE CULT OF INK
In your article “What Kind of 
Printer Are You?” (Jan/06, 

p30), I was dismayed to see 
that short shrift was given 
to the practice of refi lling 
inkjet cartridges. There 
is, in reality, a worldwide 
ink-refi lling cult out there. 
Just go online; you’ll fi nd 
an unending stream of sites 
promoting inks, offering refi ll 
tips, hosting user forums—
basically a whole shadow 
industry centered around 
avoiding exorbitant brand-
name-cartridge-replacement 
prices. Is MacAddict a voice 
of the people or a tool of the 
capitalist manufacturers? 
—Keith Greenpoint
Actually, we’re currently the 
sycophantic mouthpiece of 
the Twinkie overlords—but 
if the dreaded capitalist 
manufacturers want to bid 
against them for the favor 
of our toolhood, we’re all 
ears.—Max

SWEET OFFICE
Congratulations on your 
new offi ces. I hope your new 
environment will inspire you 

to create an even better 
magazine. Do you have a 
Web photo gallery of your 
new offi ce space I can see?
—Aleksandar Dragosavljevic
We’ll do you one better—
check out the Staff Video 
on this month’s Disc, why 
dontcha?—Max

OFFICE SUITE
If you’re looking for a great 
offi ce suite that looks like 
Word, is compatible with 

Word, doesn’t have an Offi ce 
Assistant, and is free, look at 
NeoOffi ce (www.neooffi ce
.org). Just make sure you 
have DSL—the download 
is 100MB in compressed 
format.—Ben Kimmett

A FOSSIL TO PICK
In the writeup for December’s 
“iPod Case of the Month” 
(Dec/05, p18), you claim that 
brontosaurs never existed.  
However, paleontologist O.C. 
Marsh of Yale coined both 
names (apatosaurus and 
brontosaurus), and he always 
referred to it as a brontosaur 
even after the mistake was 
discovered.—Ricky
That may be true, but 
brontosaur was offi cially 
stricken from paleontology 
records in 1974. And with 
all the evolution-related 
brouhaha these days, we 
fi gure that apatosaurus, 
dinosaur, and fossil will all 
soon be stricken from high-
school biology books.—Max

GEEK LOVE
In true geek fashion, I proposed to my girlfriend by giving 
her a brand-new black 4GB iPod nano with a marriage 
proposal engraved on the back. She was very surprised 
and said “yes,” by the way—hey, she was getting a new 
nano and a diamond ring. What more could a geek wife-
to-be want?—JD Andrews

Where’s my red stapler?

Wield Justin Guarini 
with care, for he is a 
double-edged sword.

14 hours 
of connubial 
bliss with each 
recharging.

WHAT’S YOUR BIGGEST WORRY ABOUT APPLE’S 
SWITCH TO INTEL PROCESSORS? 

tell us how you really feel

Survey 
Says
Here are the results 
of our November 
2005 survey. Check 
out www.macaddict
.com each month for 
a new online poll.

1,107 respondents

13% Apple will stop 
making hardware and 
simply license Mac 
OS X to run on Wintel 
machines.

14% Viruses, trojans, 
and worms, oh my!

11% Mac OS X will 
be as crash-prone 
as Windows.

15% Worry, shmorry—
this means more games 
on the Mac, right?

more games

dustbin

no Hardwre

like Windows

Viruses

Rosetta

Survey Says

Here are the results of our November 2005 survey. Check out 

www.macaddict.co
m each month for a new online poll.

[ART: PIE CHART]

Whatʼs your biggest worry about Appleʼs sw
itch to Intel processors? 

21% Current apps will ru
n dog-slow in Rosetta.

14% Viruses, tro
jans, and worms, oh my!

11% Mac OS X will be as cra
sh-prone as Windows.

13% Apple will sto
p making hardware and simply license Mac OS X 

to run on Wintel boxes.

26% My current Mac will be consigned to the dustbin of history.

15% Worry, shmorry—this means more games on the Mac, rig
ht?

1,107 respondents



CONTESTANT INFORMATION  
Full Name:

Address:

City:                                                               State:

Zip:

Email or telephone:    

Congratulations 
to Kurt Hegeman, 

whose caption to our photo of 
MacAddict How-To Editor Niko 
Coucouvanis earned him a copy of 
Avid Xpress Pro ($1,695, www.avid
.com)—and shame on all you guys 
’n’ gals whose suggested captions 
veered into the realm of scatology.

Winner!

vv    
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Win Roku’s SoundBridge Radio!
Got broadband? Got AirPort or Wi-Fi? Then all you need 
to access 10,000 Internet radio stations is Roku’s new 
SoundBridge Radio ($399.99, www.rokulabs.com), complete 
with subwoofer and stereo speakers. Oh, and it also plays AM/
FM radio and all your MP3, unprotected AAC, WAV, WMA and 
AIFF music fi les, either over your wireless home network or from 
an SD card or MultiMediaCard. Want it? Then make us laugh—
supply the best caption to the photo below, and it’s yours. 

79

DIRTY WINDOWS
Dan! Dan! Dan! What were 
you thinking writing an 
article about Windows 
anything (“Make Your 
Mac Look Like Windows,” 
Jan/06, p65)?! Why, why, 
why!? What’s the point?! 
There is none! MacAddict is 
my favorite Mac magazine, 
and to start 

reading articles about 
Windows or making my 
Mac look like Windows … I 
had to sit down for a while; 
I got a little dizzy; check 
please! Spill on isle six; 
Dan bumped his head! As 
Roseanne Rosannadanna 
used to say, “I thought I was 
gonna die!”—Steve
Hey, Steve! Glad you liked 
it!! We’ll be sure to do more 
Windows-related how-tos in 
the future!!!—Max

KEEPING TABS
Why hasn’t Apple applied 
Safari’s tabbed-browsing 
philosophy to the Finder 
window? It would be bloody 
handy, and it would save 
having to open, close, 
minimize, and maximize 
all the time as you jump 
between folders.—Gareth
We couldn’t agree more. In 
fact, we advocate tabbed 
anything, really—tab stops, 
Tab Hunter, guitar tabs, tabby 
cats, Tab cola—even bar tabs, 
when someone else picks 
them up.—Max

THANKS GUYS, 
PART DEUX
In Rik’s Jan/06 editorial 
(“Thanks, Guys!”, p10), 
he forgot to mention Jack 
Kilby, who invented the 
fi rst patented monolithic 
integrated circuit at Texas 
Instruments in 1958. In 
2000, he was awarded the 
Physics Nobel Prize. He 
passed away in 2005. If it 
weren’t for his initial efforts 
and others that followed, 
vacuum tubes might still 
be the norm in electronics, 
and ENIAC would still be 
considered state-of-the-
art in computing. At least 
give Mr. Kilby honorable 
mention.—James
Consider it done.—Max

������
��������

���������
����������

������

��
������
���������

�����������
�����������

��������
����

��

������

����

����������
���

����������
���

�����������
����������

���

������������������

��������
��������

����������
����������

��

���������
�����

��������
���������

��������
�������

�
��������������

����������
����������

������������������
�����������

�������

���������
���������

��������
��

���������������
���������

���

���������
���������������������

���������
������

����������
����������

����������
��������������

�������������������

� ���������
����������

����������������
��������

����������
���

�������
����������

����������
����������

����������
�����

���������
���������������

����������
���������

���������
����������

�����

���������������
������������������

���������������
�������������

���������
����������

���������
�����������������������������

������

���������
����������

���������
�����������������������������

������

��������
����������

�������������
������������������

���������
�

��������
���������

����������
������

��������
����������

�������������
������������������

���������
�

��������
���������

����������
������

�������������
���������

����������
�������������

���������
���������

��

����������
���������

����������
�����������������

��������
���������

��������������
����������

����������
����������

��������
����������

��������
����������

�����

�����������
����������

���

���������
�

����������������������

� ����������
����������������

����������
��������������

���

��������
����������

�������������
����������

����������
���

���������
���������

���������
����������

����������
����������

��

��������������
��������

������������������
����������

����

��������
���������

��������������
�����������

���������
���������

���������
���������

����������
��������������������������

����������
������������������

����������������
���������

�����

���������
���������������

���������
����������������

���������

���������
����������

������������
���������

�����������
���������

�������

���������
��������

��������������
����������

������������������

��������������������
����������

����������
����������

����������

���������������
���������

�����������
����������

�

�����������
��

��������������������

� ���������
����������������

����������
���������

��������

������������������
�����������

������������������
�������

����������
�����������

���������
���������

����������
�����������

����������
����������

���������
�����������

���������
��������������

��������
���������

�������������
���������

��������
����������

��

���������
��������

���������
���������

����������
��������������

��

���������
���������

�������������
����������

���������
���������

�����

���������������
���������

���������
����������

����������������

��������
������

��������
�����������

��������������

����������
�������

����������������

��������
������

���������
������

����������
�������

���������
���������

��

�������
����������

�

����������
����

���������
����������

����������
��������

�����

�������
����������

����������
��������

���������
�����

���������
����������

����������
��������

����������������

����������������
���������

���������
�������

��������

���������
��������

����������
���������

��������
���������

���

������������
�

���������
��������

���������
���������

��������
�����

��������
���������

���������
����������

��������
��������

���

�������������

��������
���������

���������������
��������������

����������
��������

����������
���������������

��������
���������

������

���������
�����������������

���������
���������

����������
��

���������
���������

���������
�

����������
����������

�����

���������������
���������������

���������������

����������
����������

����������
�������������

�������

���������
��������������

����������
�����������������������

���

��������
����������

�����������������������
���������

�������

���������������
�������������

�������������������
��

����������������
�����������

����������
����������

�����������
��

��������
���������

����������
����������������������

�����������
����������

����������
�����������

��

��������
���������

����������
������

�����������
���������

���������
���������

���������
������

����������������������������
����������

���������
���������

����

��������
���������

��������
���������

�

���������
���������

���������
�������

���������
���������

��������
���

�
����������������

�����������
���������

���������
����������

��

�����������������
���������

����������
�

������������
���������

����������
����

��������
����������

�������

����������
���������

��������

���������
����������

����������
��������

���������
��������

����������
����������

������

�����������
����������

�����

���������
���������

���

MacAddict goes slumming.

I’m Cou Cou for Cocoa Puffs!

Everybody! 
“O Canada! 
Our home and 
native land!”

Send email entries to: contest@macaddict.com with the subject: Roku Contest 
(Don’t forget to include your address information!)
Send snail-mail entries to: Roku Contest; MacAddict magazine; 
4000 Shoreline Court, Suite 400; South San Francisco, CA 94080.
Deadline for entry: March 31, 2006.
Contest results will appear in our July/06 issue.

Contest Rules 
The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent originality, and 
33 percent creativity. All entries must be received no later than March 31, 2006, with the winner announced around 
July 2006. By entering this contest, you agree that Future US, Inc. may use your name, likeness, and Web site for 
promotional purposes without further payment. All prizes will be awarded, and no minimum number of entries is 
required. If two or more people enter identical winning captions, the entry received fi rst will be awarded the contest 
prize. Prizes won by minors will be awarded to their parents or legal guardians. Future US, Inc. is not responsible 
for damages or expenses the winners might incur as a result of this contest or the receipt of a prize, and winners 
are responsible for income taxes based on the value of the prize received. A list of winners may also be obtained by 
sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict Contest; 4000 Shoreline Court, Suite 
400; South San Francisco, CA 94080. This contest is limited to residents of the United States. No purchase necessary, 
void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Entry Form

WIN!

WRITE TO US!
Mac Addict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080 
or letters@macaddict .com

FOR CD PROBLEMS: 
go to www.futureus-inc.com

FOR SUBSCRIPTION QUERIES: 
call (toll-free) 888-771-6222

Volume 11, Issue 3
MacAddict (ISSN 1088-548X) is published 12 times a year by Future US, Inc., 4000 Shoreline Court, Suite 400, South San 
Francisco, CA 94080. Periodicals Postage Paid at South San Francisco, CA, and at additional mailing offices. Newsstand 
distribution is handled by Curtis Circulation Co. Basic subscription rates: one year (12 issues + 12 CD-ROMs) U.S. $39.90, 
Canada $43.95, U.S. prepaid funds only. Canadian price includes postage and GST 128220688. IPM 0962392. Outside the 
U.S. and Canada, price is $53.95, U.S. prepaid funds only. POSTMASTER: Send address changes to MacAddict, P.O. Box 5126, 
Harlan, IA 51593-0626. Future US, Inc. also publishes Maximum PC, Mobile, PC Gamer, Official Xbox Magazine, PSM, Guitar 
World, Guitar One, Guitar World Acoustic, Bass Guitar, Guitar Legends, Future Music, Future Snowboarding, Snowboard Journal, 
Snowboard Trade News, Skateboard Trade News, and Scrapbook Answers. Entire contents copyright 2006, Future US, Inc.. All 
rights reserved. Reproduction in whole or in part is prohibited. Future US, Inc. is not affiliated with the companies or products 
covered in MacAddict. Ride-Along enclosure in the following edition(s): A2, B, B1, B2. PRODUCED IN THE UNITED STATES OF 
AMERICA. Publications Mail Agreement #40043631. Returns: 4960-2 Walker Road, Windsor ON N9A 6J3

Write a caption for 
this picture.

RORSCHACH, EH?
I noticed on the cover of the Nov/05 
issue that the paint sploop on the 
iMac stand looks like a red maple leaf. 
Is there a secret Canadian working 
in your midst, or more likely just 
someone who likes beer that doesn’t 
taste like water?—Paul Barker
That’s strange—you see the symbol 
of Canadian pride, and I see the 
homicidal-doll version of Jennifer 
Tilly from the hit horror-comedy Seed 
of Chucky. Then again, Ms. Tilly is 
from Canada, so maybe you’re onto 
something.—Max
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80 SHUT DOWN
don’t let the back page hit you on the way out80 SHUT DOWN
don’t let the back page hit you on the way out80 SHUT DOWN
don’t let the back page hit you on the way out
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